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Copyright

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2015 Seiko Epson Corporation. All rights reserved.

The contents of this manual and the specifications of this product are subject to change without notice.
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Trademarks

[J EPSONB® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a
trademark of Seiko Epson Corporation.

(4 PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

[ EPSON Scan software is based in part on the work of the Independent JPEG Group.
1 libtiff

Copyright © 1988-1997 Sam Leftler

Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED
OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

(d SDXC Logo is a trademark of SD-3C, LLC.

Y 4
xXC

(d Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick Micro, and
MagicGate Memory Stick Duo are trademarks of Sony Corporation.

Vs )N

MEMORY STICK ™

«

PictBridge
USB LAN WIAN
Vv v

[J PictBridge is a trademark.

J Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

[d Apple, Macintosh, Mac OS, OS X, Bonjour, Safari, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple
Inc,, registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.
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[ Google Cloud Print™, Chrome™, Chrome OS™, and Android™ are trademarks of Google Inc.

(4 Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

[ Intel® is a registered trademark of Intel Corporation.

[J General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.
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About This Manual

Introduction to the Manuals

The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

[ Start Here (paper manual)

Provides you with information on setting up the printer, installing the software, using the printer, solving
problems, and so on.

[d User's Guide (digital manual)

This manual. Provides overall information and instructions on using the printer, and on solving problems.
[d Network Guide (digital manual)

Provides information on network settings and solving problems when using the printer on a network.
You can obtain the latest versions of the above manuals with the following methods.

(d Paper manual

Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

(J Digital manual

Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information
= “EPSON Software Updater” on page 129

Marks and Symbols

A Caution:

Instructions that must be followed carefully to avoid bodily injury.

n Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

= Related Information

Links to related sections.


http://www.epson.eu/Support
http://support.epson.net/
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About This Manual

Descriptions Used in this Manual

[ Screenshots of the printer driver and the EPSON Scan (scanner driver) screens are from Windows 8.1 or Mac
OS X v10.10.x. The content displayed on the screens varies depending on the model and situation.

[ Tllustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

[d Some of the menu items on the LCD screen vary depending on the model and settings.

Operating System References

Windows

In this manual, terms such as "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista", and "Windows XP" refer
to the following operating systems. Additionally, "Windows" is used to refer to all versions.

(d Microsoft® Windows® 8.1 operating system
(d Microsoft® Windows® 8 operating system

[d Microsoft® Windows® 7 operating system

[J Microsoft® Windows Vista® operating system
d Microsoft® Windows® XP operating system

(d Microsoft® Windows® XP Professional x64 Edition operating system

Mac OS X

In this manual, "Mac OS X v10.10.x" refers to OS X Yosemite, "Mac OS X v10.9.x" refers to OS X Mavericks, and
"Mac OS X v10.8.x" refers to OS X Mountain Lion. Additionally, "Mac OS X" is used to refer to "Mac OS X
v10.10.x", "Mac OS X v10.9.x", "Mac OS X v10.8.x", "Mac OS X v10.7.x", and "Mac OS X v10.6.8".

10
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Important Instructions

Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

(d Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

[d Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the printer's manuals.

(d Unplug the printer and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

[d Place the printer near a wall outlet where the plug can be easily unplugged.

(d Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

[d Take care not to spill liquid on the printer and not to handle the printer with wet hands.

[d Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

[ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

(d Be careful when you handle ink cartridges, as there may be some ink around the ink supply port.
[ If ink gets on your skin, wash the area thoroughly with soap and water.

[ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

(1 If ink gets into your mouth, see a doctor right away.
(d Do not disassemble the ink cartridge; otherwise ink may get into your eyes or on your skin.

(4 Do not shake ink cartridges too vigorously and do not drop them. Also, be careful not to squeeze them or tear
their labels. Doing so may cause ink leakage.

[d Keep ink cartridges out of the reach of children.

Printer Advisories and Warnings

Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

1
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Important Instructions

Advisories and Warnings for Setting Up/Using the Printer

(d Do not block or cover the vents and openings in the printer.

[d Use only the type of power source indicated on the printer's label.

[d Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
[d Avoid electrical outlets controlled by wall switches or automatic timers.

[ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

[ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

[ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

(d When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

[J Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

[d When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

(d Allow space above the printer so that you can fully raise the document cover.
[d Leave enough space in front of the printer for the paper to be fully ejected.

[d Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.

(d Do not insert objects through the slots in the printer.

[d Do not put your hand inside the printer during printing.

(d Do not touch the white flat cable inside the printer.

(d Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
(4 Do not move the print head by hand; otherwise, you may damage the printer.

[d Be careful not to trap your fingers when closing the scanner unit.

(4 Do not press too hard on the scanner glass when placing the originals.

[d Always turn the printer off using the O button. Do not unplug the printer or turn off the power at the outlet
until the O light stops flashing.

[J Before transporting the printer, make sure that the print head is in the home (far right) position and the ink
cartridges are in place.

[ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

12
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Advisories and Warnings for Using the Printer with a Wireless

Connection

[d Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing
them to malfunction. When using this printer inside medical facilities or near medical equipment, follow

directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

[J Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using Memory Cards

(d Do not remove a memory card or turn off the printer while the memory card light is flashing.

(J The methods for using memory cards vary according to card type. Be sure to refer to the manual packaged with
your memory card for details.

(d Use only memory cards compatible with the printer.

Related Information

= “Supported Memory Card Specifications” on page 158

Advisories and Warnings for Using the Touchscreen

[d The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

[J Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

[d The exterior cover of the touchscreen could break if it receives a heavy impact. Contact your dealer if the panel
surface chips or cracks, and do not touch or attempt to remove the broken pieces.

[J Press the touchscreen gently with your finger. Do not press force or operate with your nails.
[J Do not use sharp objects such as ball point pens or sharp pencils to perform operations.

(J Condensation inside the touchscreen due to abrupt changes in temperature or humidity may cause
performance to deteriorate.

Protecting Your Personal Information

When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting Setup > Restore Default Settings > All Settings on the control panel.

13
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Printer Basics

Part Names and Functions

(1) Rear paper feed slot Load one sheet of paper at a time by hand.

(2] Paper support Supports loaded paper.

(3) Rear paper feed slot cover Prevents foreign substance from entering the printer. This cover should
usually be closed.

(4) Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.

(5] CD/DVD tray Place a CD/DVD for label printing. This should usually be stored on the
bottom of the printer.

(1) Ink cartridge holder

Install the ink cartridges. Ink is ejected from the print head nozzles
underneath.

(2] Scanner unit

Scans placed originals. Open to replace ink cartridges or to remove jammed
paper. This unit should usually be kept closed.

14
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(3] Control Panel Operates the printer.

(1) Front cover Open to load paper in the paper cassette.

(2] Output tray Holds the ejected paper. When you start printing, this tray is ejected
automatically. If you select Yes on the screen displayed when the printer is
turned off, it is stored automatically. If it is not stored, push it in with your

hand.
(3] Paper cassette 1 Loads paper.
(4] Paper cassette 2
(5) Edge guide Feeds the paper straight into the printer. Slide to the edges of the paper.
(1) Document cover Blocks external light while scanning.

15
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(2] Scanner glass Place the originals.
(3] Memory card slot Insert a memory card.
(4] External interface USB port Connects an external storage device or a PictBridge capable device.

(1) ACinlet Connects the power cord.

(2] Rear cover Remove when removing jammed paper.

(3] LAN port Connects a LAN cable.

(4] USB port Connects a USB cable to connect with a computer.

(5] Vent Releases heat from the inside of the printer. Vents are on the bottom right,
bottom left, and on the right-hand side. Do not cover the vents when placing
the printer.

Control Panel

You can change the angle of the control panel.

16
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Note:
(A When turning on the printer, the control panel rises automatically. When turning on the next time, the panel rises to the
same angle as the last time you turned the power off.

(3 If you start printing with the control panel closed, it rises automatically and the output tray is ejected.

Buttons

Al] available buttons, except for the power button, are displayed on the LCD screen.

(1) e ©

G

(©) A

o 3

00

(1] (I) Turns the printer on or off.

Do not turn off while the power light is flashing (while the printer is operating or processing
data).

Unplug the power cord when the power light is off.

(2] ﬂ Displays the home screen.

(3) AV Scrolls the screen up or down to select a menu item.
(4] A Opens or closes the output tray.

(5) 5 Returns to the previous screen.

(6] @ Starts an operation such as printing or copying.

Guide to the LCD Screen

Menus and messages are displayed on the LCD screen. Touch the screen to select a menu or make settings.

Guide to the Home Screen

The following icons and menus are displayed on the home screen.

17
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Printer Basics

(1] Copy Enters Copy mode that allows you to copy a document.
Print Photos Enters Print Photos mode that allows you to print photos on your memory card.
Scan Enters Scan mode that allows you to scan a document or a photo.

e Press € or P to display hidden menu icons.

More Functions Enters More Functions mode that allows you to access a variety of printing features such as
copying photos, printing photos in different layouts, and copying or printing on a CD/DVD.

Setup Enters Setup mode that allows you to make maintenance, printer setup, and network settings.

Help Displays help information on basic operations, meaning of the icons displayed on the LCD
screen, and troubleshooting information.

Quiet Mode Displays Quiet Mode setting that allows you to reduce the noise the printer makes. However,
enabling this may reduce print speed. Depending on the paper type and print quality settings
you selected, there may be no difference in the printer's noise level. This is a shortcut to the
following menu.

Setup > Printer Setup > Quiet Mode

(3] Displays the network connection status. Press this icon to access the menus for network setup or for checking the
network settings as described below. You can also access the network menus from the Setup mode.

[ When the printer is not connected to a network

Press an icon of your desired connection method, and press Start Setup on the next screen to display the
network setup menus. To setup the printer for use on a network using the menus, see the Network Guide.

(4 When the printer is connected to a network

Press See Connection Details to display the setting information such as the printer's IP address. Press Menu to
display the network setup menus. Press Details to display the menus for check the status such as a menu for
printing a network status sheet.

Related Information

= “Copying” on page 80

= “Printing from the Control Panel” on page 43

= “Copying Photos” on page 83

= “Printing in Various Layouts” on page 50

= “Scanning Using the Control Panel” on page 87

= “Menu Options for Setup Mode” on page 113

= “Menu Options for Network Settings” on page 115

Scrolling the LCD Screen

You can scroll the screen by touching A W 4P or by using the following swiping actions.

(d Swipe the center of the screen.
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Printer Basics

(J Swipe a bit harder if the touch screen does not respond.

Print Settings

Cassette 2

Borderless

Displaying a Menu Appropriate to the Operation

The printer automatically displays menus appropriate to your operation as shown below. If you want to stop the
feature, disable the Auto Selection Mode setting.

Setup > Guide Functions > Auto Selection Mode
[ Insert a memory card.

Henus
"% Print Photos

&8 Scan to Memory Card

=] More
Functions

Menus

’ Copy

-
&= ocan

Hore
Functions

Related Information

= “Menu Options for Guide Functions” on page 117

Entering Characters

To enter numbers, characters or symbols for network settings, use the keyboard on the LCD screen.
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Printer Basics

The displayed screen varies depending on the setting items. The following is the screen for entering the password
for your Wi-Fi network.

Enter Password

2 aeC 3oer

4 Gt 5k 6 mo Space

Icons Descriptions

Space Enters a space to the right of the cursor.

Deletes a character to the left (backspace).

Moves the cursor to the left or right.

Done Accepts the entry and closes the keyboard screen. A confirmation screen or the next screen is
displayed.
'I Symb Displays "1", and then displays symbols when the button is pressed twice or more.
2 I\:le Displays and switches numbers and characters between "ABC" (uppercase characters), "abc"

(lowercase characters), and "2" each time the button is pressed. The other number/character
buttons function in the same way.
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Loading Paper

Loading Paper

Paper Handling Precautions

[d Read the instruction sheets supplied with the paper.
[d Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the

printable side.

[ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

OQ

[d Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

[J Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

e &

[d Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

(d Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

[J Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

= “Printer Specifications” on page 155
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Loading Paper

Available Paper and Capacities

Epson recommends using genuine Epson paper to ensure high-quality printouts.

Genuine Epson Paper

Media Name Size Loading Capacity (Sheets) 2-Sided Borderless
Printing*! Printing*2
Paper Paper Rear
Cassette 1 Cassette 2 Paper
Feed Slot

Epson Bright White A4 - 80"3 1 Auto, -
Ink Jet Paper Manual
Epson Ultra Glossy A3 - - 1 - v
Photo Paper

A4 - 20 1

13%18 cm (5%7 in.), 20 20 1

10x15 cm (4%6 in.)
Epson Premium A3 - - 1 - v
Glossy Photo Paper

A4 - 20 1

13%18 cm (5%7 in.), 20 20 1

16:9 wide size

(102%x181 mm),

10x15 cm (4%6in.)
Epson Premium A3 - - 1 - v
Semigloss Photo
Paper A4 - 20 1
EpsonPhoto Paper | 13,18 ¢m (5x7in), | 20 20 1
Glossy 10x15 cm (4x6 in.)
Epson Matte Paper- A3 - - 1 - v
Heavyweight

A4 - 20 1
Epson Double- A4 - 1 - Auto, v
Sided Matte Paper Manual
Epson Photo A3 - - 1 - -
Quiality Ink Jet
Paper A4 - 80 1
Epson Iron-On Cool A4 - 1 1 - -
Peel Transfer
Paper
Epson Photo A6 1 1 1 - -
Stickers™

*1  The 2-sided printing feature is not available for the rear paper feed slot.

*2  Borderless printing is not available for 2-sided printing.

*3  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.
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*4  Only printing from computer is available.

Note:

Loading Paper

The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

Commercially Available Paper

Media Name Size Loading Capacity (Sheets or Envelopes) 2-Sided Borderless
Printing™’ Printing
Paper Paper Rear
Cassette 1 Cassette 2 Paper
Feed Slot
Plain paper™2 A3,B4"3 - - 1 - -
Letter'3, A4, B5 ™3 - Up to the 1 Auto,
line Manual
indicated
A5 - by the 1 Manual
triangle
symbol on
the edge
guide.™
Legal 3 - 1 1 Manual
A6™3 20 20 1 Manual
User Defined"3 - 15 1 Manual
Envelope™ Envelope #10, - 10 1 - -
Envelope DL,
Envelope C6

*1  The 2-sided printing feature is not available for the rear paper feed slot.

*2  Use the rear paper feed slot to load pre-punched paper.

*3  Only printing from computer is available.

*4  For manual 2-sided printing, you can load up to 30 sheets for paper with one side already printed.

*5  Use the rear paper feed slot to load paper longer than A4 size.

Related Information
® “Part Names and Functions” on page 14

= “Technical Support Web Site” on page 165

List of Paper Types

To obtain optimum printing results, select the paper type that suits the paper.
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Loading Paper

Media Name

Media Type

Control Panel

Printer Driver, Smart device

*2
Epson Bright White Ink Jet Paper”’ plain papers plain papers
Epson Ultra Glossy Photo Paper’’ Ultra Glossy Epson Ultra Glossy
Epson Premium Glossy Photo Paper"! Prem. Glossy Epson Premium Glossy

Epson Premium Semigloss Photo Paper"!

Prem. Semigloss

Epson Premium Semigloss

Epson Photo Paper Glossy™

Glossy

Photo Paper Glossy

Epson Matte Paper-Heavyweight'!

Epson Double-Sided Matte Paper’!

Matte

Epson Matte

Epson Photo Quality Ink Jet Paper™!

Photo Quality IJ

Epson Photo Quality Ink Jet

Epson Iron-On Cool Peel Transfer Paper

plain papers

plain papers

Epson Photo Stickers™

Photo Stickers

Epson Photo Stickers

Plain paper”’

plain papers

plain papers

Envelope

Envelope

Envelope

*1  These paper types are compatible with Exif Print and PRINT Image Matching when printing from the printer driver. For more

details, see the documentation provided with the Exif Print or PRINT Image Matching compatible digital camera.

*2  For smart devices, these media types can be selected when printing using Epson iPrint.

Loading Paper in the Paper Cassette 1

You can load small size photo paper. If you load the same paper in paper cassette 2 and select Cassette 1->2 as the
Paper Source setting in the print settings, the printer automatically feeds paper from paper cassette 2 when paper
runs out in paper cassette 1.

Note:

When the output tray is ejected, check that there is no paper on the tray, and then close it by pressing the A button or
pushing it with your hand.

1. Raise the control panel.

<X
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Loading Paper

2. Open the front cover until it clicks.

3. Check that the printer is not operating, and then pull out paper cassette 1. Paper cassette 1 has an alignment

mark }} that allows you to locate it easily.

n Important:

If paper cassette 1 is too far inside the printer, turn the printer off and on again.

4. Slide the edge guides to their maximum position.

5. Slide the front edge guide to the paper size you want to use.

KG / 4x6”

10x15¢cm
2L/ 5x7”
> 13x18cm

16:9
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Loading Paper

6. With the printable side facing down, load paper against the front edge guide.

n Important:

0 Make sure the paper does not extend beyond the triangle symbol at the end of the cassette.

=D=

L

[ Do not load more than the maximum number of sheets specified for the paper. Do not load paper above the
line indicated by the triangle symbol on the edge guide.

[ Photo Sticker sheet

Follow the instructions supplied with the stickers to load one sheet of Photo Stickers. Do not load the
loading support sheets into this product.
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7.

8.

10.

11.

Loading Paper

Slide the right edge guide to the edge of the paper.

Insert paper cassette 1. Line up the alignment marks on the printer and the tray.

Check the paper size and paper type settings displayed on the control panel. To use the settings, press
Confirm. To change the settings, press Change, and then go to the next step.

Note:
The paper setting screen is not displayed if you have disabled Paper Configuration in the following menus.

Setup > Printer Setup > Paper Source Setting > Paper Configuration
Select the paper size and then select the paper type on the next screen.

Check the paper settings you selected, and then press Done.

Note:
(d You can also display the paper size and paper type settings screen by selecting the paper source in the following
menus.

Setup > Printer Setup > Paper Source Setting > Paper Setup

(A The output tray slides out automatically when printing starts. To eject the tray before printing starts, press the A
button.

Related Information

= “Paper Handling Precautions” on page 21

= “Available Paper and Capacities” on page 22

= “Menu Options for Paper and Print Settings” on page 53
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Loading Paper

Loading Paper in the Paper Cassette 2

You can load almost any type of paper. We recommend loading A4 size plain paper as this is used frequently. If you
load the same paper in paper cassette 1 and select Cassette 1->2 as the Paper Source setting in the print settings,
the printer automatically feeds paper from paper cassette 2 when paper runs out in paper cassette 1.

Note:
When the output tray is ejected, check that there is no paper on the tray, and then close it by pressing the A button or
pushing it with your hand.

1. Raise the control panel.

2. Open the front cover until it clicks.

3. Check that the printer is not operating, and then pull out paper cassette 2.

4. Slide the edge guides to their maximum position.
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Loading Paper

5. Slide the front edge guide to the paper size you want to use.

4 )
LTR } t ‘
A4
= N ’_\G
\ J/

6. With the printable side facing down, load paper against the front edge guide.

n Important:
[ Make sure the paper does not extend beyond the triangle symbol at the end of the cassette.

v
al

d Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the triangle symbol on the edge guide.
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Loading Paper

[d Envelopes

[ Photo Sticker sheet

Follow the instructions supplied with the stickers to load one sheet of Photo Stickers. Do not load the
loading support sheets into this product.

-~
AY

|:\’l

7. Slide the right edge guide to the edge of the paper.

S
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Loading Paper

8. Insert paper cassette 2.

>

9. Check the paper size and paper type settings displayed on the control panel. To use the settings, press
Confirm. To change the settings, press Change, and then go to the next step.

Note:
The paper setting screen is not displayed if you have disabled Paper Configuration in the following menus.

Setup > Printer Setup > Paper Source Setting > Paper Configuration
10. Select the paper size and then select the paper type on the next screen.

11. Check the paper settings you selected, and then press Done.

Note:
[ You can also display the paper size and paper type settings screen by selecting the paper source in the following
menus.

Setup > Printer Setup > Paper Source Setting > Paper Setup

(A The output tray slides out automatically when printing starts. To eject the tray before printing starts, press the A
button.

Related Information

= “Paper Handling Precautions” on page 21

= “Available Paper and Capacities” on page 22

= “Menu Options for Paper and Print Settings” on page 53

Loading Paper in the Rear Paper Feed Slot

You can load a single sheet of all types of supported paper in the rear paper feed slot. You can also load thick paper
(up to 0.6 mm thick) and pre-punched paper, which cannot be loaded in the paper cassette. However, even if the
thickness is within this range, some paper may not be fed correctly depending on the hardness.

g Important:

Do not load paper in the rear paper feed slot until the printer prompts you to do so. Doing so will result in the blank
paper being ejected.

1. Do one of the following.
[ When printing from the control panel: Select rear paper feed slot as the Paper Source setting, make other

print settings, and then press the <> button.
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Loading Paper

[ When printing from a computer: Select rear paper feed slot as the Paper Source setting, make other print
settings, and then click Print.

2. A message is displayed on the screen telling you that the printer is preparing, and then you are instructed to
load paper. Follow the instructions below to load the paper.

3. Open the rear paper feed slot cover.

e

4.

5. Slide out the edge guides.
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Loading Paper

6. Load a single sheet of paper at the center of the rear paper feed slot with the printable side facing up, and then
insert it approximately 5 cm into the printer. You hear a beep when the paper is set correctly.

Note:
The beep does not sound if you have disabled Button Press in the following menus.

Setup > Printer Setup > Sound > Button Press

[d Envelopes

[d Pre-punched paper

Note:
(d Load a single sheet of paper without binding holes at the top and bottom.

(d Adjust the print position of your file to avoid printing over the holes.
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Loading Paper

7. Slide the edge guides to the edges of the paper.

8. Press the < button to start printing.

Related Information
= “Paper Handling Precautions” on page 21
= “Available Paper and Capacities” on page 22
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Placing Originals on the Scanner Glass

Placing Originals on the Scanner Glass

n Important:

When placing bulky originals such as books, prevent exterior light from shining directly onto the scanner glass.

1.

2.

3.

Open the document cover.

Remove any dust or stains on the scanner glass.

Place the original face-down and slide it to the corner mark.

Note:
A range of 1.5 mm from the edges of the scanner glass is not scanned.

[d When copying photos, place the photos 5 mm away from the corner mark of the scanner glass.
You can place up to two photos at the same time (depending on the size). Leave 5 mm between photos.

You can place photos of different sizes at the same time. The photos should be larger than 30 x 40mm.

A =5mm (0.27) A
>i &
A
10.5x15¢cm :
(4x6") > €
. v
T ioswsom 12:717;8om
N (4x6”) J
A A
+
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Placing Originals on the Scanner Glass

(d To copy a CD/DVD label, place the CD/DVD in the center of the scanner glass. If the CD/DVD is not
placed exactly in the center, the positioning is automatically adjusted.

[ If you are scanning using Full Auto Mode or thumbnail preview in EPSON Scan, place the original 4.5 mm
away from the corner mark of the scanner glass.

Place multiple photos at least 20 mm apart from each other.

The photos should be larger than 15 x 15 mm.

4.5mm
(0.2
—p Nl—
15mm
(0.6")
20mm
(0.8")
15mm ~ :
(0.6")
4.5mm

4. Close the cover gently.

Note:
Remove the originals after scanning or copying. If you leave the originals on the scanner glass for a long time, they may
stick to the surface of the glass.
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Inserting a Memory Card

Inserting a Memory Card

Supported Memory Cards

Memory Stick Duo

TE

— MeoRv Smick Duo Memory Stick PRO Duo

Memory Stick PRO-HG Duo
MagicGate Memory Stick Duo

- i < Memory Stick Micro”
d28
]

T . e *
=) Ea miniSD
iE é

miniSDHC"

microSD”
microSDHC”
microSDXC”

SD
SDHC
SDXC

CompactFlash

Microdrive

Microdrive™

%
o\

*  Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.

Related Information

= “Supported Memory Card Specifications” on page 158

Inserting and Removing a Memory Card

1. Inserta memory card into the printer.

The printer starts reading the data and the light flashes. When reading is complete, the light stops flashing and
remains on.
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Inserting a Memory Card

n Important:

Do not try to force the card all the way into the slot. It should not be fully inserted.

2. When you have finished using the memory card, make sure the light is not flashing, and then remove the card.

n Important:

If you remove the memory card while the light is flashing, the data in the memory card may be lost.

Note:
If you access the memory card from a computer, you need to operate the computer to safely remove the removable
device.

Related Information

= “Accessing a Memory Card From a Computer” on page 164
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Loading a CD/DVD for Printing

Loading a CD/DVD for Printing

Printable CD/DVDs

You can print on a circular 12-cm CD/DVD labelled as suitable for printing, for example "printable on the label
surface" or "printable with ink jet printers.” To print on a CD/DVD with a higher quality print surface, select
CD/DVD Premium Surface as the Paper Type in the printer driver.

You can also print on Blu-ray Discs™.

CD/DVD Handling Precautions

[d See the documentation provided with your CD/DVD for more information on handling the CD/DVD or
writing data.

([ Do not print on the CD/DVD before writing your data to it. If you do, fingerprints, dirt, or scratches on the
surface may cause errors while writing data.

(d Depending on the CD/DVD type or printing data, smearing may occur. Try making a test print on a spare CD/
DVD. Check the printed surface after waiting for one full day.

(d Compared to printing on genuine Epson paper, the print density is lowered to prevent ink from smearing on the
CD/DVD. Adjust the print density as necessary.

(d Allow the printed CD/DVDs at least 24 hours to dry avoiding direct sunlight. Do not stack or insert the CD/
DVDs into your device until they are completely dry.

[ If the printed surface is sticky even after it has dried, lower the print density.
[d Reprinting on the same CD/DVD may not improve the print quality.

(4 If the CD/DVD tray or the internal transparent compartment are accidentally printed on, immediately wipe oft
the ink.

[d Depending on the print area setting, the CD/DVD or CD/DVD tray may get dirty. Make settings to print on the
printable area.

Related Information
= “Printable Area for CD/DVD” on page 156

Loading a CD/DVD

g Important:

1 Before printing on the CD/DVD, see the CD/DVD handling precautions.
1 Do not insert the CD/DVD tray while the printer is operating. This may damage the printer.

1 Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the CD/DVD is
ejected.
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Loading a CD/DVD for Printing

Note:

When the output tray is ejected, check that there is no paper on the tray, and then close it by pressing the A button or
pushing it with your hand.

1. Send print data from a computer, or select a menu to print on the CD/DVD and follow the on-screen
instructions on the control panel.

2. A message is displayed on the screen telling you that the printer is preparing, and then you are instructed to
load a CD/DVD. Follow the instructions below to load the CD/DVD.

3. Raise the control panel.

4. Close the front cover.

5. Remove the CD/DVD tray from the bottom of the printer
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Loading a CD/DVD for Printing

6. Place a CD/DVD on the CD/DVD tray with the printable side face-up. Press the center of the CD/DVD to
securely set it on the tray.

7. Insert the CD/DVD tray into the printer. Line up the alignment marks on the printer and the tray.

8. Select Ready, and then touch OK.

Related Information

= “Printable CD/DVDs” on page 39

= “CD/DVD Handling Precautions” on page 39

= “Printing Photos from a Memory Card onto a CD/DVD Label” on page 44
= “Printing a CD/DVD Label with Epson Print CD” on page 73

= “Copying on a CD/DVD Label” on page 84
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Loading a CD/DVD for Printing

Removing a CD/DVD

1. Remove the CD/DVD tray when it is ejected automatically after printing, and then remove the CD/DVD from
the tray.

2. Touch OK.

3. Insert the CD/DVD tray back into the slot on the bottom of the printer.

n Important:

After printing is finished, make sure you remove the CD/DVD tray and store it at the bottom of the printer. If
you do not remove the tray and turn the printer on or off, or run head cleaning, the CD/DVD tray will strike
the print head and may cause the printer to malfunction.

Related Information
= “CD/DVD Handling Precautions” on page 39
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Printing

Printing

When printing on A3-size paper, use of large capacity Epson genuine ink cartridges is highly recommended to
avoid a situation that you are prompted to replace ink cartridges in the middle of printing. If you replace ink
cartridges in the middle of printing, you may need to start over the printing again.

Related Information

= “Ink Cartridge Codes” on page 97

Printing from the Control Panel

Printing Photos by Selecting from a Memory Card

1.

Load paper in the printer.

n Important:
[ When loading in the paper cassette, make the paper settings on the control panel.

[ When loading in the rear paper feed slot, do not load paper now. When you select the rear paper feed slot as

the paper source setting, and then press the < button, the printer will prompt you to load paper. Follow the
instructions to load the paper.

Insert a memory card into the printer.

n Important:

Do not remove the memory card until you have finished printing.

Note:
Remove the memory card when printing from an external storage device such as a hard disk or USB flash memory.

Select Print Photos on the control panel.

Select a photo you want to print from the screen displaying a thumbnail view.

Note:
[ Ifyou have a lot of photos on your memory card, you can sort photos to select them easily by pressing Options >
Browse.

HEE
A You can change the number of photos displayed in thumbnail view by pressing ﬂ
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Printing

5. Set the number of copies using - or +. When printing more than one photo, select a photo using <or P, and
then repeat this procedure.

Note:
A If you want to show a photo without indicators, such as buttons when one photo is displayed on a screen, press
anywhere on the screen except for the buttons. Press anywhere again to show the buttons.

A You can display Exif information such as the shooting date and shutter speed by pressing on the upper right
side of the screen.

[d Press Edit, and then select Crop/Zoom to crop a part of a photo. Use A, ; , 4, or> on the screen to move
the frame to the area you want to crop, and then press e ora to change the size of the frame. Press to

rotate the frame.

6. Press Settings to make the paper and print settings.

7. Press the < button. When printing from the rear paper feed slot, press the <> button, and then load paper
when you are instructed to do so.

Related Information

= “Ink Cartridge Codes” on page 97

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “List of Paper Types” on page 23

= “Inserting a Memory Card” on page 37

= “Menu Options for Printing from the Control Panel” on page 51

Printing Photos from a Memory Card onto a CD/DVD Label

You can select photos stored on a memory card to print onto a CD/DVD label.

1. Inserta memory card into the printer.

g Important:

Do not remove the memory card until you have finished printing.

2. Select More Functions > Print on CD/DVD on the control panel.
3. Select the layout.

4. Check the screen, and then press Proceed. For CD/DVD 4-up, select whether to place photos automatically or
manually.
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10.

11.

12.

13.

Printing

Select a photo, set the number of copies, and then press Proceed. When placing photos manually for CD/DVD

4-up, after displaying the photo you want to print using d or P>, press Place Photo. If you want to leave a
blank space, press Leave Blank.

Note:
(A The available number of copies is displayed at the top of the screen where you select the photos you want to print and
the number of copies. You can select photos until 0 is indicated.

[d Press Edit, and then select Crop/Zoom to crop a part of a photo. Use A, ; , 4, or> on the screen to move
the frame to the area you want to crop, and then press e ora to change the size of the frame.

Set the outer and inner diameter using A or ¥, and then press Proceed.

Note:
You can set 114 to 120 mm as the outer diameter, and 18 to 46 mm as the inner diameter in 1 mm increments.

Select Print on a CD/DVD.

Note:
For test printing, select Test print on A4 paper, and then load A4 plain paper in the paper cassette. You can check the
printout image before printing on a CD/DVD label.

A message is displayed on the screen telling you that the printer is getting ready. You are then instructed to
load a CD/DVD. Press ¥ to check the instructions and load a CD/DVD.

Press Ready, a message is displayed telling you that the printer is ready, and then press OK.

Change the print density settings as necessary.

Press the < button.

When printing has finished, the CD/DVD tray is ejected. Remove the tray from the printer, and then press
OK.

Remove the CD/DVD and store the CD/DVD tray on the bottom of the printer.

Related Information

= “Inserting a Memory Card” on page 37

= “Loading a CD/DVD” on page 39

= “Removing a CD/DVD” on page 42

= “Menu Options for Printing from the Control Panel” on page 51

Printing Photos from a Memory Card with Handwritten Notes

You can print a photo on a memory card with handwritten text or drawings. This allows you to create original
cards such as New Year's cards or birthday cards.
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Printing

First select a photo and print a template on plain paper. Write or draw on the template and then scan it with the
printer. You can then print the photo with your own personal notes and drawings.

1. Inserta memory card into the printer.

n Important:

Do not remove the memory card until you have finished printing.

2. Select More Functions > Greeting Card > Select Photo and Print Template on the control panel.
3. Select a photo on the screen displaying a thumbnail view, and then press Proceed.

4. Make print settings such as the paper type or layout for printing a photo with handwritten notes, and then
press Proceed.

5. Load A4-size plain paper in paper cassette 2 to print a template.

n Important:

Make the paper settings on the control panel.

6. Press the < button to print a template.

7. Follow the instructions on the template to write and draw.

8. Press A to close the output tray. Load photo paper in paper cassette 1.

n Important:

Make the paper settings on the control panel.

9. Select Print Greeting Cards from Template.

10. Check the screen, place the written template on the scanner glass, and then press Proceed.

Note:
Make sure that the text on the template is completely dry before placing it on the scanner glass. If there are stains on the
scanner glass, the stains are also printed on the photo.

11. Set the number of copies, and then press the <> button.
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Related Information

= “Inserting a Memory Card” on page 37

= “Menu Options for Printing from the Control Panel” on page 51
= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Paper Cassette 1” on page 24

= “List of Paper Types” on page 23

= “Placing Originals on the Scanner Glass” on page 35

Printing Original Writing Paper and Calendars

You can easily print lined paper, calendars, original writing paper and greeting cards using the Personal
Stationery menu.

1. Load paper in the printer.

n Important:

[ When loading in the paper cassette, make the paper settings on the control panel.

instructions to load the paper.

[ When loading in the rear paper feed slot, do not load paper now. When you select the rear paper feed slot as
the paper source setting, and then press the <> button, the printer will prompt you to load paper. Follow the

2. To print writing paper, greeting cards, or a monthly calendar using a photo on your memory card, insert the

memory card into the printer.
3. Select More Functions > Personal Stationery from the home screen.

4. Select a menu item.

Note:

When printing greeting cards, you can add an image stored in the printer instead of using a photo on your memory

card. To add an image stored in the printer, select Template Art.

5. Follow the on-screen instructions to print.
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Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “List of Paper Types” on page 23

= “Inserting a Memory Card” on page 37

= “Menu Options for Printing Original Writing Paper and Calendars” on page 48
= “Menu Options for Printing from the Control Panel” on page 51

Menu Options for Printing Original Writing Paper and Calendars

Lined Papers

Prints some types of lined paper, graph paper, or music paper.

Writing Papers

Prints some types of writing paper with a photo from the memory card set as the background. The
photo is printed lightly so that it can be easily written on.

Calendar

Prints a weekly or monthly calender. Select the year and the month for the monthly calendar.

Message Card

Prints a greeting card using images from the printer or images on the memory card.

[ Image Position

Select where you want to place the image on the greeting card.

(d Line Type

Select the type of ruled line to print on the greeting card.

[ Line Color

Select the color of the ruled line to print on the greeting card.

Printing Original Envelopes

You can create original envelopes by adding an image stored in the printer using the Personal Stationery menu.
You can use the same image to print greeting cards that match the envelopes.
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1. Enter More Functions from the home screen.

2. Select Personal Stationery.

3. Select Origami.

4. Select Origami Envelope.

5. Select the image you want to print on the envelopes.

6. Change the image position and the fold line settings as necessary.

7. Press Proceed.

A screen indicating the print position of the image, and whether to print fold lines is displayed.
8. Check the settings, and then press Proceed.
9. Select the size of the envelopes.

10. Load A4 plain paper in the paper cassette, and then press Proceed.

11. Set the number of copies, and then press the <> button.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

Folding Envelopes

After printing a diagram of an envelope, print an instruction sheet that shows you how to fold the envelope, and
then lay the instruction sheet on top of the diagram and fold them together.

1. Select Origami Envelope Instruction from the Origami menu.
2. Select the envelope size that you selected when printing the envelope diagram.

3. Load A4 plain paper in the paper cassette, and then press Proceed.
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4. Set the number of copies, and then press the <> button.

The following instruction sheet is printed.

5. Lay the instruction sheet on top of the envelope diagram, and then fold them together following the
instructions on the instruction sheet.

6.  When finished, unfold them and remove the instruction sheet, and then fold only the envelope diagram again
along its creases.

Printing Photos Using Other Features

This section introduces the other printing features available using the control panel.

Printing in Various Layouts

You can print the photos on your memory card in various layouts such as 2-up, 4-up, and upper half.

Select More Functions > Photo Layout Sheet from the home screen, and then follow the on-screen instructions to
print.

Related Information

= “Menu Options for Printing from the Control Panel” on page 51
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Printing a Coloring Book

You can print a coloring sheet by extracting only the outline of photos or illustrations. This allows you to create
unique coloring books.

A

g
o
|:|I> X &E;' ,%
L
Note:

Unless they are being used for personal use (at home or other restricted areas), you need permission from the copyright
holder when using copyright protected originals to create a coloring book.

Select More Functions > Coloring Book, select whether to scan an original or use a photo on a memory card to
print a coloring book, and then follow the on-screen instructions.

Related Information
= “Menu Options for Selecting Photos” on page 51
= “Menu Options for Paper and Print Settings” on page 53

DPOF Printing

This printer is compatible with DPOF (Digital Print Order Format) Ver. 1.10. DPOF is a format that stores
additional information for photos such as the date, time, user name, and printing information. DPOF-compatible
cameras allow you to set which image on a memory card to print and the number of copies. When the memory
card is inserted into the printer, the photos selected by the camera are printed.

Note:

For information on making print settings on your camera, see the documentation provided with your camera.

When you insert a memory card into the printer, a confirmation screen is displayed. Select Yes to display the print
settings screen. Press the <> button to start printing. If you want to change the print settings, display the items

using the A or ¥ button, and then make settings. Setting items are the same as in Print Photos mode.

Related Information
= “Printing Photos by Selecting from a Memory Card” on page 43
= “Menu Options for Printing from the Control Panel” on page 51

Menu Options for Printing from the Control Panel

Menu Options for Selecting Photos

Browse
[d Browse by Date

Displays the photos on the memory card sorted by date. Select a date to display all photos saved on
that date.
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[ Cancel Browse

Cancels sorting photos and displays all the photos.

Select Photos
[ Select All Photos

Selects all the photos on the memory card and sets the number of prints.

[ Cancel Photo Selection

Returns the number of prints of all photos to 0 (zero).

Select Location
Select Folder

If this option is enabled when you connect an external storage device, select a folder.

Menu Options for Photo Adjustment and Zoom

Enhance

Select one of the image adjustment options. PhotoEnhance produces sharper images and more vivid
colors by automatically adjusting the contrast, saturation, and brightness of the original image data.

J Auto

The printer detects the image content and automatically enhances the image according to the
detected content.

(4 People

Recommended for images of people.

[d Landscape

Recommended for images of landscape or scenery.

(d Night Scene

Recommended for images of night scenes.

J PIM.

Adjusts the image based on the printing information provided by a digital camera compatible with
PRINT Image Matching.

[ Enhance Off

Turns off the Enhance feature.

Scene Detection

Available when selecting PhotoEnhance as the Enhance setting. Improves the image quality for photos
of people, landscapes, and night scenes.

Fix Red-Eye

Fixes red-eye in photos. Corrections are not applied to the original file, only to the printouts. Depending
on the type of photo, parts of the image other than the eyes may be corrected.
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Brightness
Adjusts the brightness of the image.

Contrast
Adjusts the difference between the brightness and darkness.

Sharpness

Enhances or defocuses the outline of the image.

Saturation

Adjusts the vividness of the image.

Filter

Prints in sepia or monochrome.
Crop/Zoom
Enlarges a part of the photo to be printed.
Menu Options for Paper and Print Settings

Paper Size
Select the paper size you loaded.

Paper Type
Select the paper type you loaded.

Paper Source

Select the paper source that you want to use.

Layout
Select the layout you want to use.

Quality
Select the print quality. Selecting Best provides higher quality printing, but the printing speed may be
slower.

Borderless
Prints without margins around the edges. The image is enlarged a little to remove borders from the
edges of the paper.

Expansion
With borderless printing, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Date

Select the format used to print the date on photos for photos that include the date the photos were taken
or the date they were saved. The date is not printed for some layouts.
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Print Info. On Photos
O Off

Prints without any information.

[d Camera Settings
Prints with some Exif information, such as shutter speed, f-ratio, or ISO sensitivity. Unrecorded
information is not printed.

[ Camera Text

Prints text set on the digital camera. For information on the text settings, see the documentation
provided with your camera. The information can only be printed in borderless printing on 10x15
cm, 13x18 cm, or 16:9 wide size.

J Landmark

Prints the name of the place or landmark where the photo was taken for digital cameras that have the
landmark feature. See the website of the manufacturer of your camera for more details. The
information can only be printed in borderless printing on 10x15 cm, 13x18 cm, or 16:9 wide size.

Fit Frame

If the aspect ratio of the image data and the paper size is different, the image is automatically enlarged
or reduced so that the short sides match the short sides of the paper. The long side of the image is
cropped if it extends beyond the long side of the paper. This feature may not work for panorama photos.

Bidirectional

Prints while the print head moves to the left and to the right. If vertical or horizontal ruled lines on your
printout look blurred or misaligned, disabling this feature may solve the problem; however, doing so
may reduce print speed.

Clear All Settings
Resets the paper and print settings to their defaults.

CD Density
For CD/DVD printing. Set the density to use when printing onto a CD/DVD.

Frame

For greeting card printing. Select the frame you want to print.

Paper Settings
For coloring book printing. Select the paper size and paper type you loaded.

Density

For coloring book printing. Select the level of density for the outlines on the coloring sheet.

Line Detection

For coloring book printing. Select the sensitivity used to detect outlines in the photo.

54



User's Guide

Printing

Printing from a Computer

Printing Basics - Windows

Note:
[ See the online help for explanations of the setting items. Right-click an item, and then click Help.

[d Operations differ depending on the application. See the application's help for details.

1.

Load paper in

the printer.

n Importa

nt:

1 When loading in the paper cassette, make the paper settings on the control panel.

[ When loading in the rear paper feed slot, start printing from the printer driver before loading paper. Select
Rear Paper Feed Slot as the Paper Source setting on the printer driver. When printing starts, the printer
driver tells you that printing is in progress. Follow the printer’s on-screen instructions to load paper.

Open the file you want to print.

Select Print or Print Setup from the File menu.

Select your pri

nter.

Select Preferences or Properties to access the printer driver window.

-

e

Printing Preferences

Main | More Options | Maintenance |

| Auto

Printing Presets Paper Source W |
| Add/Remove Presets... Dacument Size | A4 210 x 297 mm v I
J:I Document - Fast [1Borderless Settings...
& .
=] Document - Standard Quality Crientation (@) Portrait (") Landscape
28 Document - High Quality
j{[ Document - 2-Sided Paper Type | plain papers o
:I Document - A3 :
f Photo - 10 x 15 cm Portrait Quality |Standard v
8 Photo - 10 x 15 cm Landscape Color (@) Color () Grayscale
(=) Printable CO/DVD Printing
£ Photo - A4 Portrait 2-Sided Printing | Off v
ws Photo - A4 Landscape
| Settings... | Print Density...
| —— Multi-Page Off (V] Page Order...
T | o
‘II_I copes [1_ 2] W
| — []reverse Order
Quiet Mode iDFF W
| Show Settings | D Print Preview
[]3ob Arranger Lite
| Reset Defaults | | Ink Levels
OK || Cancel || Hebp

55




User's Guide

6.

7.

8.
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Make the following settings.
[d Paper Source: Select the paper source in which you loaded the paper.
(d Document Size: Select the paper size you loaded in the printer.

[d Borderless: Select to print with no margins around the image.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Click Settings to select the amount of enlargement.

[d Orientation: Select the orientation you set in the application.

[d Paper Type: Select the type of paper you loaded.

[d Color: Select Grayscale when you want to print in black or shades of gray.
Note:

When printing on envelopes, select Landscape as the Orientation setting.

Click OK to close the printer driver window.

Click Print.

Related Information

= “Available Paper and Capacities” on page 22

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “Guide to Windows Printer Driver” on page 121

= “List of Paper Types” on page 23

Printing Basics - Mac OS X

Note:
Explanations in the section use TextEdit as an example. Operations and screens differ depending on the application. See the
application’s help for details.

1.

2.

Load paper in the printer.

Important:
1 When loading in the paper cassette, make the paper settings on the control panel.

d When loading in the rear paper feed slot, select Rear Paper Feed Slot as the Paper Source setting on the
printer driver, and then start printing before loading paper. Start printing, click the printer icon in the Dock
to display the print screen. Follow the printer's on-screen instructions to load paper.

Open the file you want to print.
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3. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details or ¥ to expand the print window.

Printer:  EPSON XXXX |~
Presets: Default Settings [T
Copies: 1

Pages: © All

From: 1 to: 1
Paper Size: A4 w 210 by 297 mm

Orientation: Ti' LIFS

TextEdit i

Print header and footer
Rewrap contents to fit page

cancel (EZITNN

4. Make the following settings.
[ Printer: Select your printer.
[ Presets: Select when you want to use the registered settings.
[ Paper Size: Select the paper size you loaded in the printer.
When printing with no margins, select a "borderless" paper size.
(d Orientation: Select the orientation you set in the application.

Note:
[ If the above setting menus are not displayed, close the print window, select Page Setup from the File menu, and then
make settings.

[d When printing on envelopes, select landscape orientation.
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Select Print Settings from the pop-up menu.

Printer: EPSON XXXX

(ON O

Presets: Default Settings

Copies: 1

Pages: OAII
From: 1 to: 1

Paper Size: A4 ﬁ 210 by 297 mm
Orientation: | | il Te
Print Settings ki

Paper Source: Cassette 2

Media Type: plain papers

(OROR O

Print Quality: Normal

Expansion: Max °
Grayscale
Mirror Image

Cancel [N

Note:
On Mac OS X v10.8.x or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

http://epson.sn

Make the following settings.

[d Paper Source: Select the paper source in which you loaded the paper.

If you enable the Automatic Cassette Switching function, the printer automatically feeds paper from paper
cassette 2 when paper runs out in paper cassette 1. Load the same paper (type and size) in paper cassette 1
and paper cassette 2.

To enable the Automatic Cassette Switching function, select System Preferences from the ‘ menu >
Printers & Scanners (or Print & Scan, Print & Fax), and then select the printer. Make settings on the
screen displayed by clicking Options & Supplies > Options (or Driver).

[d Media Type: Select the type of paper you loaded.

[J Expansion: Available when selecting a borderless paper size.

In borderless printing, the print data is enlarged slightly more than the paper size so that no margins are
printed around the edges of the paper. Select the amount of enlargement.

[d Grayscale: Select to print in black or shades of gray.

Click Print.
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Related Information

= “Available Paper and Capacities” on page 22

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Guide to Mac OS X Printer Driver” on page 125

= “List of Paper Types” on page 23

Printing on 2-Sides
You can use either of the following methods to print on both sides of the paper.

(J Automatic 2-sided printing

(d Manual 2-sided printing (for Windows only)
When the printer has finished printing the first side, flip the paper over to print on the other side.

You can also print a booklet that can be created by folding the printout. (For Windows only)

9

7
N

I
/X
/1

Note:
(A This feature is not available for borderless printing.

[ 2-sided printing is not available using the Rear Paper Feed Slot.
[ If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.
[d Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

= “Available Paper and Capacities” on page 22

Printing on 2-Sides - Windows

Note:

d Manual 2-sided printing is available when EPSON Status Monitor 3 is enabled. If EPSON Status Monitor 3 is disabled,
access the printer driver, click Extended Settings on the Maintenance tab, and then select Enable EPSON Status
Monitor 3.

(A Manual 2-sided printing may not be available when the printer is accessed over a network or is used as a shared printer.

59



User's Guide

Printing

1. Load paper in the printer.
2. Open the file you want to print.
3. Access the printer driver window.

4. Select Auto (Long-edge binding), Auto (Short-edge binding), Manual (Long-edge binding), or Manual
(Short-edge binding) from 2-Sided Printing on the Main tab.
5. Click Settings, make the appropriate settings, and then click OK.
Note:
To print a folded booklet, select Booklet.
6. Click Print Density, select the document type from Select Document Type, and then click OK.
The printer driver automatically sets the Adjustments options for that document type.

Note:
(1 Printing may be slow depending on the combination of options selected for Select Document Type in the Print
Density Adjustment window and for Quality on the Main tab.

(A For manual 2-sided printing, the Print Density Adjustment setting is not available.
7. Set the other items on the Main and More Options tabs as necessary, and then click OK.

8. Click Print.

For manual 2-sided printing, when the first side has finished printing, a pop-up window is displayed on the
computer. Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24
= “Loading Paper in the Paper Cassette 2” on page 28
= “Printing Basics - Windows” on page 55

Printing on 2-Sides - Mac OS X

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the print dialog.

4. Select Two-sided Printing Settings from the pop-up menu.
5. Select the bindings in Two-sided Printing.

6. Select the type of original in Document Type.

Note:
(A Printing may be slow depending on the Document Type setting.

A If you are printing high-density data such as photos or graphs, select Text with Photo or Photo as the Document
Type setting. If scuffing occurs or the image bleeds through to the reverse side, adjust the print density and ink drying
time by clicking the arrow mark next to Adjustments.
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7. Set the other items as necessary.

8. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24
= “Loading Paper in the Paper Cassette 2” on page 28
= “Printing Basics - Mac OS X” on page 56

Printing Several Pages on One Sheet

You can print two or four pages of data on a single sheet of paper.

| —
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Printing Several Pages on One Sheet - Windows

Note:
This feature is not available for borderless printing.

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select 2-Up or 4-Up as the Multi-Page setting on the Main tab.

5. Click Page Order, make the appropriate settings, and then click OK to close the window.
6. Set the other items on the Main and More Options tabs as necessary, and then click OK.
7. Click Print.

Related Information
= “Loading Paper in the Paper Cassette 1” on page 24
= “Loading Paper in the Paper Cassette 2” on page 28
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= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “Printing Basics - Windows” on page 55

Printing Several Pages on One Sheet - Mac OS X

1.

7.

Load paper in the printer.

Open the file you want to print.

Access the print dialog.

Select Layout from the pop-up menu.

Set the number of pages in Pages per Sheet, the Layout Direction (page order), and Border.
Set the other items as necessary.

Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Printing Basics - Mac OS X” on page 56

Printing to Fit the Paper Size

You can print to fit the paper size you loaded in the printer.

&

7
N

¢

Printing to Fit the Paper Size - Windows

Note:
This feature is not available for borderless printing.

1.

2.

Load paper in the printer.

Open the file you want to print.
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Access the printer driver window.

Make the following settings on the More Options tab.
(4 Document Size: Select the paper size you set in the application.

[d Output Paper: Select the paper size you loaded in the printer.
Fit to Page is selected automatically.

Note:
If you want to print a reduced image at the center of the page, select Center.

Set the other items on the Main and More Options tabs as necessary, and then click OK.

Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “Printing Basics - Windows” on page 55

Printing to Fit the Paper Size - Mac OS X

1.

Load paper in the printer.

Open the file you want to print.

Access the print dialog.

Select the size of the paper you set in the application as the Paper Size setting.
Select Paper Handling from the pop-up menu.

Select Scale to fit paper size.

Select the paper size you loaded in the printer as the Destination Paper Size setting.
Set the other items as necessary.

Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Printing Basics - Mac OS X” on page 56
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Printing Multiple Files Together (for Windows Only)

Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as layout, print order, and orientation.

(=

-

1
N
[ E—
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17\”:;)2‘;611 a Print Project saved in Job Arranger Lite, click Job Arranger Lite on the printer driver's Maintenance tab. Next,
select Open from the File menu to select the file. The extension of the saved files is "ecl”.

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select Job Arranger Lite on the Main tab.

5. Click OK to close the printer driver window.

6. Click Print.
The Job Arranger Lite window is displayed and the print job is added to the Print Project.

7.  With the Job Arranger Lite window opened, open the file that you want to combine with the current file, and
then repeat steps 3 to 6.

Note:
If you close the Job Arranger Lite window, the unsaved Print Project is deleted. To print later, select Save from the File
menu.

8. Select the Layout and Edit menus in Job Arranger Lite to edit the Print Project as necessary.

9. Select Print from the File menu.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Printing Basics - Windows” on page 55
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Printing One Image on Multiple Sheets to Create a Poster (for
Windows Only)

This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping

them together.
-
Note:

This feature is not available for borderless printing.

'ﬁ.HIHH

1. Load paper in the printer.

2. Open the file you want to print.

3. Access the printer driver window.

4. Select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster from Multi-Page on the Main tab.
5. Click Settings, make the appropriate settings, and then click OK.

6. Set the other items on the Main and More Options tabs as necessary, and then click OK.

7. Click Print.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Printing Basics - Windows” on page 55
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Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.

sheet1I <:> lsheet2

@
—,

sheet 3 sheet 4

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.

4 h

B K sheet2 H B sheet1 ¥ sheet2 K
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.

4 N\
\__ J
] . / m
¥ sheet1 sheet2 H
:i'\ ‘\/:
2] 2]
= ™ =

3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).

4 _ )
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/
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8 sheet1 ! sheet2 ¥ B sheet1 sheet2 K
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4. Tape the sheets together from the back.
(-] -] ™
B sheet1 sheet2 H
B B
= & =

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.

4 )

< [>:] 0= [>:]
¥ sheet1 sheet2 K
4
\_
Q N
(]
D e e ol

68



User's Guide

7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then

temporarily tape them together from the back.

(

~N

Printing

[
B sheet1 sheet2 H
N
R Ssheet3 sheet4 g
= X
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).

4 )

& 5] [13] 5]
=y B sheet1 sheet2 H

/1 sheet 2

5 sheet 3 i sheet 4 = g sheet3 sheet4 g
= X ]
9. Tape the sheets together from the back.
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10. Cut off the remaining margins along the outer guide.
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Printing Using Advanced Features

This section introduces a variety of additional layout and printing features available on the printer driver.

Related Information

= “Windows Printer Driver” on page 121
= “Mac OS X Printer Driver” on page 124

Adding a Printing Preset to Print Easily

If you create your own preset of frequently used print settings on the printer driver, you can print easily by
selecting the preset from the list.
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Windows

To add your own preset, set items such as the Document Size and Paper Type on the Main or More Options tab,
and then click Add/Remove Presets in Printing Presets.

Note:
To delete an added preset, click Add/Remove Presets, select the preset name you want to delete from the list, and then delete
it.

Mac OS X

Access the print dialog. To add your own preset, set items such as the Paper Size and Media Type, and then save
the current settings as the preset in the Presets setting.

Note:
To delete an added preset, click Presets > Show Presets, select the preset name you want to delete from the list, and then
delete it.

Printing a Reduced or Enlarged Document

You can reduce or enlarge the size of a document by a specific percentage.

Windows
Note:

This feature is not available for borderless printing.

Set the Document Size on the More Options tab. Select Reduce/Enlarge Document, Zoom to, and then enter a
percentage.

Mac OS X
Note:
Operations differ depending on the application. See the application’s help for details.

Select Page Setup (or Print) from the File menu. Select the printer from Format For, select the paper size, and
then enter a percentage in Scale. Close the window, and then print following the basic printing instructions.

Adjusting the Print Color

You can adjust the colors used in the print job.

PhotoEnhance produces sharper images and more vivid colors by automatically adjusting the contrast, saturation,
and brightness of the original image data.

Note:
[ These adjustments are not applied to the original data.

[ PhotoEnhance adjusts the color by analyzing the location of the subject. Therefore, if you have changed the location of
the subject by reducing, enlarging, cropping, or rotating the image, the color may change unexpectedly. Selecting the
borderless setting also changes the location of the subject resulting in changes in color. If the image is out of focus, the tone
may be unnatural. If the color is changed or becomes unnatural, print in a mode other than PhotoEnhance.

Windows
Select the method of color correction from Color Correction on the More Options tab.

If you select Automatic, the colors are automatically adjusted to match the paper type and print quality settings. If
you select Custom and click Advanced, you can make your own settings.
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Mac OS X

Access the print dialog. Select Color Matching from the pop-up menu, and then select EPSON Color Controls.
Select Color Options from the pop-up menu, and then select one of the available options. Click the arrow next to
Advanced Settings and make the appropriate settings.

Printing a Watermark (for Windows Only)

You can print a watermark such as "Confidential" on your printouts. You can also add your own watermark.

Note:
This feature is not available with borderless printing.

Click Watermark Features on the More Options tab, and then select a watermark. Click Settings to change details
such as the density and position of the watermark.

Printing a Header and Footer (for Windows Only)

You can print information such as a user name and printing date as headers or footers.

Click Watermark Features in the More Options tab, and then select Header/Footer. Click Settings and select
necessary items from the drop-down list.

Printing Photos Using Epson Easy Photo Print
Epson Easy Photo Print lets you lay out and print photos easily on various types of paper. See the application's help
for details.

Note:
[d By printing on genuine Epson photo paper, the ink quality is maximized and the printouts are vivid and clear.

A To perform borderless printing using a commercially available application, make the following settings.

[ Create image data to fit the paper size. If a margin setting is available in the application you are using, set the margin
to 0 mm.

0 Enable the borderless printing setting in the printer driver.

Related Information

= “Epson Easy Photo Print” on page 128

Printing a CD/DVD Label with Epson Print CD

Epson Print CD lets you easily create and print an original design CD/DVD label. You can also create and print a
CD/DVD jacket.
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You can set the print range for the CD/DVD to a minimum of 18 mm for the inner diameter, and a maximum of
120 mm for the outer diameter. Depending on the settings, the CD/DVD or tray may be smeared. Set within the
print range for the CD/DVD you want to print.

See the application's help for details.

Note:
When printing a CD/DVD label using a commercially available application, make the following settings.

[d For Windows, A4 is automatically selected as the Document Size setting when you select CD/DVD Tray as the Paper
Source setting. Select Portrait as the Orientation setting, and CD/DVD or CD/DVD Premium Surface as the Paper
Type setting.

(4 For Mac OS X, select A4 (CD/DVD) as the Paper Size setting. Select portrait as the printing direction, and then select
CD/DVD or CD/DVD Premium Surface as the Media Type on the Print Settings menu.

[d On some applications, you may need to specify the tray type. Select Epson Tray Type 2. The setting name may vary
slightly depending on the application.

Related Information
= “Epson Print CD” on page 128

Printing from Smart Devices

Using Epson iPrint

Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same
wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.

EPSON

Related Information

= “Epson Connect Service” on page 119

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a
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Printing Using Epson iPrint
Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice.

(1] e

seese 7 19:41 2% [ L L] & 19:41 2% -

Epson iPrint @ £ Home Photos l & '— e

35x5in/89x 127 mm

Camera
Capture

Deselect Rotate

(1) Home screen displayed when the application is started.

®

Displays information on how to setup the printer and a FAQ.

(3] Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

(4] Select what you want to print such as photos, documents, and web pages.
(5] Displays the screen to make print settings such as paper size and paper type.
(6] Displays the paper size. When this is displayed as a button, press it to display the paper settings currently

set on the printer.

(7] Displays photos and documents you selected.

(3] Starts printing.

Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.
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Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and
Mac with the latest version of OS X.

AirPrint

Note:
If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.

1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

http://epson.sn
3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

Note:
For details, see the AirPrint page on the Apple website.

Related Information

= “Cannot Use AirPrint” on page 142

= “Loading Paper in the Paper Cassette 1” on page 24
= “Loading Paper in the Paper Cassette 2” on page 28
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Printing from a Digital Camera

Note:
A You can print photos directly from a PictBridge-compatible digital camera. For more details on making operations on
your camera, see the documentation provided with your camera.

A Usually digital camera settings are given priority; however, in the following situations, the printer settings are given
priority.

[ When the camera's print setting is set to "use printer settings”
 When the Sepia or B&W option is selected in the printer's print settings.

 When combining the print settings of the camera and the printer produces settings that are not available on the
printer.

[d When printing on a CD/DVD, make the print settings on the printer before selecting photos on the digital camera, and
then start printing. However, depending on your digital camera, you may not be able to print photos with DPOF settings
on a CD/DVD.

[d You can print photos with DPOF settings directly from a camera.

Printing from a Digital Camera Connected by USB Cable

You can print photos directly from a digital camera connected by USB cable.

1. Remove a memory card from the printer.

2. Load paper in the printer.

3. Select Setup > External Device Setup from the home screen.

4. Select Print Settings or Photo Adjustments and change the settings if necessary.

5. Turn on the digital camera, and then connect to the printer using a USB cable.

4 )

S
N

=
l
Note:

Use a USB cable that is shorter than two meters.

4

@

6. Select the photos you want to print from the digital camera, make settings such as the number of copies, and
then start printing.
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Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Menu Options for Photo Adjustment and Zoom” on page 52

= “Menu Options for Paper and Print Settings” on page 53

Printing from a Digital Camera Connected Wirelessly

You can wirelessly print photos from digital cameras that support the DPS over IP standard (from here on referred
to as PictBridge (wireless LAN)).

1.

Make sure the icon that indicates that the printer is connected to a wireless network is displayed on the home
screen.

Note:
To learn the meaning of the icons, select Help > Icon List on the control panel.

Load paper in the paper cassette.

Select Setup > External Device Setup from the home screen.

Select Print Settings or Photo Adjustments and change the settings if necessary.
Connect the digital camera to the same network as the printer.

Display the list of available printers on the digital camera, and then select the printer you want to connect to.

Note:
(A To check the printer's name, press the network status icon on the home screen.

A If your digital camera has a function that allows you to register printers, you can connect to the printer by selecting it
from the next time.

Select the photos you want to print from the digital camera, make settings such as the number of copies, and
then start printing.

Disconnect the PictBridge (wireless LAN) connection to the printer from the digital camera.

g Important:

When using PictBridge (wireless LAN), you cannot use other printer functions or print from other devices.
Disconnect immediately when you have finished printing.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Menu Options for Photo Adjustment and Zoom” on page 52

= “Menu Options for Paper and Print Settings” on page 53
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Canceling Printing

Note:
A In Windows, you cannot cancel a print job from the computer once it has been completely sent to the printer. In this case,
cancel the print job by using the printer's control panel.

(A When printing several pages from Mac OS X, you cannot cancel all of the jobs by using the control panel. In this case,
cancel the print job from the computer.

[ Ifyou have sent a print job from Mac OS X v10.6.8 through the network, you may not be able to cancel printing from the
computer. In this case, cancel the print job by using the printer’s control panel.

Canceling Printing - Printer Button

Press the & button to cancel the print job in progress.

Canceling Printing - Windows
1. Access the printer driver window.

2. Select the Maintenance tab.

3. Click Print Queue.

4. Right-click on the job you want to cancel and then select Cancel.

Related Information

= “Windows Printer Driver” on page 121

Canceling Printing - Mac OS X
1. Click the printer icon in the Dock.
2. Select the job you want to cancel.

3. Cancel the job.
[ Mac OS X v10.8.x or later

Click next to the progress meter.

[ Mac OS X v10.6.8 to v10.7.x
Click Delete.
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Copying Basics

1. Load paper in the printer.

Important:
[ When loading in the paper cassette, make the paper settings on the control panel.

[ When loading in the rear paper feed slot, do not load paper now. When you select the rear paper feed slot as

the paper source setting, and then press the <> button, the printer will prompt you to load paper. Follow the
instructions to load the paper.

2. Place the originals.

3. Select Copy on the control panel.

4. Set the number of copies using - or +.
5. Select color copy or monochrome copy.

6. Check the settings such as the paper size and the paper type and change settings if necessary.

Note:
If you want to copy by reducing or enlarging the size of a document by a specific percentage, select Custom Size as the
Reduce/Enlarge setting, and enter a percentage on the screen displayed.

7. Press the < button. When printing from the rear paper feed slot, press the <> button, and then load paper
when you are instructed to do so.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Placing Originals on the Scanner Glass” on page 35

= “Menu Options for Copy Mode” on page 80

Menu Options for Copy Mode

Note:
Available menus vary depending on the layout you selected.

The number of copies

Enter the number of copies.

Preview

Shows a scanned image to preview the copy results.
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B&W

Density

Copying

Copies the original in color.

Copies the original in black and white (monochrome).

Increase the level of density by pressing P when the copying results are faint. Decrease the level of

density by pressing d when ink smears.

Remove Background

Detects the paper color (background color) of the original document, and removes or lightens the color.
Depending on the darkness and vividness of the color, it may not be removed or lightened.

2-Sided Copying

Layout

[ 1>1-Sided

Copies one side of an original onto a single side of paper.

A 1>2-Sided

Copies two single-sided originals onto both sides of a single sheet of paper.

[ With Border

Copies with margins around the edges.

[ Borderless

Copies without margins around the edges. The image is enlarged a little to remove borders from the
edges of the paper.

4 A4, 2-up Copy

Copies two A4 single-sided originals onto a single sheet of A4 size paper in 2-up layout.

You can also copy onto a single sheet of A3 size paper. A4 size originals can be copied almost at their
original size in 2-up layout.

d A4, Book/2-up

Copies two A4 facing pages of a book and so on onto a single sheet of A4 size paper in 2-up layout.

You can also copy onto a single sheet of A3 size paper. A4 size originals can be copied almost at their
original size in 2-up layout.

[ Book/2-Sided

Copies two separate pages of a book and so on onto both sides of a single sheet of paper. Only
available when 1>2-Sided is selected as the 2-sided copying setting.

Reduce/Enlarge

Enlarges or reduces the originals.

[ Custom Size
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Specifies the magnification used to enlarge or reduce the original within a range of 25 to 400%.

[ Actual Size

Copies at 100 % magnification.

[ Auto Fit Page

Detects the scan area and automatically enlarges or reduces the original to fit to the paper size you
selected. When there are white margins around the original, the white margins from the corner mark
of the scanner glass are detected as the scan area, but the margins at the opposite side may be
cropped.

Hello!

J 10x15cm->A4, A4->10x15cm, and others

Automatically enlarges or reduces the original to fit to a specific paper size.

Paper Size
Select the paper size you loaded.

Paper Type
Select the paper type you loaded.

Paper Source

Select the paper source that you want to use.

Document Type
Select the type of your original.

Quality

Select the quality for copying. Selecting Best provides higher quality printing, but the printing speed
may be slower.

Document Orientation

Select the orientation of your original.

Binding Margin
Select the binding position of the copies.

Expansion
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With borderless copying, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Dry Time

Select the drying time for 2-sided copying. Increase the level of drying time when ink smears.

Clear All Settings
Resets the copy settings to their defaults.

Copying Photos

You can copy multiple photos at the same time. You can also restore the colors in faded photos.

Note:
[ The smallest size of original you can copy is 30 x 40 mm.

[d White space around the photo may not be detected.

1. Load paper in the printer.

g Important:

1 When loading in the paper cassette, make the paper settings on the control panel.

1 When loading in the rear paper feed slot, do not load paper now. When you select the rear paper feed slot as

the paper source setting, and then press the <> button, the printer will prompt you to load paper. Follow the
instructions to load the paper.

2. Select More Functions on the control panel.
3. Select Copy/Restore Photos.
4. Select whether or not to restore the colors in faded photos.

5. Place the photos on the scanner glass following the instructions displayed on the screen.

6. Press the <> button.

The photos are scanned and displayed on the screen.

7. Press Settings, check the settings such as the paper size and the paper type, and then change the settings if
necessary.

Note:
Press Edit to adjust the colors in the photos. If you want to print by enlarging part of a photo, select Crop/Zoom. Move

the frame of the print area using A V, 4, or D and change the frame size usinga or @

8. Press the <> button.

Related Information
= “Loading Paper in the Paper Cassette 1” on page 24
= “Loading Paper in the Paper Cassette 2” on page 28
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= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Placing Originals on the Scanner Glass” on page 35
= “Menu Options for Copy/Restore Photos” on page 84

Menu Options for Copy/Restore Photos

Photo Adjustments

Selecting PhotoEnhance as the Enhance setting enhances the image automatically by using Epson's
unique image analysis and image processing technology.

Filter

Copies in monochrome.

Crop/Zoom
Enlarges a part of the photo to be copied.

Paper Size

Select the paper size you loaded.

Paper Type
Select the paper type you loaded.

Paper Source

Select the paper source that you want to use.

Borderless

Copies without margins around the edges. The image is enlarged a little to remove borders from the
edges of the paper.

Expansion

With borderless copying, the image is enlarged a little to remove borders from the edges of the paper.
Select how much to enlarge the image.

Copying on a CD/DVD Label

You can copy a disc label or a square original such as a photo onto a CD/DVD label.

g Important:

Do not load a CD/DVD into the printer until you are instructed to do so.

1. Select More Functions on the control panel.
2. Select Copy to CD/DVD.

3. DPlace the original following the instructions displayed on the screen, and then press Proceed.
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4. Set the printing area by specifying the inner diameter and the outer diameter, and then press Proceed.
Note:
You can set 114 to 120 mm as the outer diameter, and 18 to 46 mm as the inner diameter in 1 mm increments.
5. Select Print on a CD/DVD.

Note:
To make a test print, select Test print on A4 paper, and then load A4 plain paper in the paper cassette 2. You can check
the printout image before printing on a CD/DVD label.

6. A message is displayed on the screen telling you that the printer is getting ready. You are then instructed to
load a CD/DVD. Press ¥ to check the instructions and load a CD/DVD.

7. Press Ready, a message is displayed telling you that the printer is ready, and then press OK.
8. Select color copy or monochrome copy.

9. Change the other settings if needed.

Note:
Press Preview to view the scanned image. You can adjust the printing position on the preview screen.

10. Press the <> button.

11. When printing has finished, the CD/DVD tray is ejected. Remove the tray from the printer, and then press
OK.

12. Remove the CD/DVD and store the CD/DVD tray on the bottom of the printer.

Related Information

® “Placing Originals on the Scanner Glass” on page 35
= “Loading a CD/DVD” on page 39

= “Menu Options for Copy to CD/DVD” on page 85
= “Removing a CD/DVD” on page 42

Menu Options for Copy to CD/DVD

Outer, Inner

Specify the print range. Up to 120 mm for the outer diameter, and a minimum of 18 mm for the inner
diameter can be specified. Depending on the setting, the CD/DVD or CD/DVD tray may get dirty. Set
the range to fit the printable area of your CD/DVD.

Print Type (Print on a CD/DVD or Test print on A4 paper)

Select whether to print on a CD/DVD or make a test print on A4 size plain paper. When you select Test
print on A4 paper, you can check the print result before printing on a CD/DVD.

Preview

Start scanning the original and displays the scanned image. You can adjust the printing position on the
preview screen.

Color
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Copies the original in color.

B&W
Copies the original in black and white (monochrome).
Density
Increase the level of density by pressing P when the copying results are faint. Decrease the level of

density by pressing d when ink smears.

Document Type
Select the type of your original.

Quality

Select the copy quality when printing a test on A4 size plain paper. Selecting Best provides higher
quality printing, but the printing speed may be slower.
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Scanning Using the Control Panel

Scanning to a Memory Card

You can save the scanned image to a memory card.
1. Inserta memory card into the printer.

2. Place the originals.

3. Select Scan on the control panel.

4. Select Scan to Memory Card.

5. Check settings such as the save format, and change them if necessary.

6. Press the < button.

Related Information

® “Placing Originals on the Scanner Glass” on page 35
= “Inserting a Memory Card” on page 37

= “Menu Options for Scanning” on page 89

Scanning to the Cloud

You can send scanned images to could services using the Scan to Cloud feature. Before using this feature, make
settings using Epson Connect. See the following Epson Connect portal website for details.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

1. Make sure that you have made settings using Epson Connect.
2. Place the originals.

3. Select Scan on the control panel.

4. Select Scan to Cloud.

5. Select a destination.

6. Select Settings, check settings such as the save format, and then change them if necessary.

7.  Press the <> button.
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Related Information

= “Epson Connect Service” on page 119

= “Placing Originals on the Scanner Glass” on page 35
= “Menu Options for Scanning” on page 89

Scanning to a Computer

You can save the scanned image to a computer.

n Important:

Make sure you have installed EPSON Scan and Epson Event Manager on your computer before using this feature.

1. Place the originals.
2. Select Scan on the control panel.

3. Select how to save the scanned image to a computer from the following menus.
[d Scan to Computer (JPEG): Saves the scanned image in JPEG format.
[d Scan to Computer (PDF): Saves the scanned image in PDF format.
(d Scan to Computer (Email): Starts the email client on your computer, and then automatically attaches it to
an email.
4. Select a computer on which to save the scanned images.

Note:
(A You can change to frequently-used scan settings such as the document type, folder to save, or save format by using
Epson Event Manager.

(A When the printer is connected to a network, you can select the computer to which you want to save the scanned
image. Up to 20 computers can be displayed on the printer's control panel.

(A When the computer to which you want to save the scanned images is detected on the network, the initial 15
characters of the computer name are displayed on the control panel. If you set Network Scan Name
(Alphanumeric) in Epson Event Manager, it is displayed on the control panel.

5. Press the < button.

Related Information
= “Placing Originals on the Scanner Glass” on page 35
= “Epson Event Manager” on page 127

Scanning to a Computer (WSD)

Note:
(A This feature is only available for computers running Windows 8.1/Windows 8/ Windows 7/Windows Vista.

(A If you are using Windows 7/ Windows Vista, you need to setup your computer in advance using this feature. See the
Network Guide for more details.

1. Place the originals.

88



User's Guide

Scanning

o

Select Scan on the control panel.
3. Select Scan to Computer (WSD).

4. Select a computer.

5. Press the <> button.

Related Information

= “Placing Originals on the Scanner Glass” on page 35

Menu Options for Scanning

The following options are available on the Scan to Memory Card menu and Scan to Cloud menu.

Note:
Available options vary depending on the menu selected.

JPG
Saves the scanned image in JPEG format.
PDF
Saves the scanned image in PDF format.
Color
Select to scan the original in color.
B&W
Select to scan the original in monochrome.
Contrast
Select the contrast of the scanned image. Increase the level of contrast by pressing P> and decrease by
pressing <4
Scan Area
Select the scan area. To crop the white space around the text or image when scanning, select Auto
Cropping. To scan at the maximum area of the scanner glass, select Max Area. Select this setting and
scan again if the edges of the scanned image are cropped when A4 is selected.
Document
Select the type of your original.
Resolution

Select the scanning resolution.

Document Orientation

Select the orientation of your original.

Clear All Settings
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Resets the scan settings to their defaults.

Scanning from a Computer

Scan using the scanner driver "EPSON Scan". See the EPSON Scan help for an explanation of each setting item.

Scanning Basics

This section uses EPSON Scan's Home Mode to explain the basics of scanning. The operation work flow is the
same in other scanning modes.

1. Place the originals.
2. Start EPSON Scan.

3. Select Home Mode from the Mode list.

tode:

..v
F EPSDN SCEH |H|:|meh-1|:u:|l3

Document Type

'5/ Photograph

Image Type
(@) Color () Grayscale () Blackiwhite

Deztination

() Screen/web () Printer () Other

Rezolution: 300 dpi

Target Size: Original Al

Image Adjustrents
[ | Descreening [ ] Backlight Comection
[ ] Color Restoration [ Dust Bemaoyal
Image Dption(z]
® Teut Enhancenment
Auto Area Segmentation

Brightness...

‘ Lj Preview

Thumbnail

Help Configuration. ..
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4. Make the following settings.
d Document Type: Select the type of the original you want to scan.
[d Image Type: Select the color type of the image you want to scan.
Although this is automatically selected by the Document Type setting, you can change the setting.
[d Destination: Select the resolution of the image you want to scan.
If you select Other, you can set Resolution.

(4 Thumbnail: Only available if you select Photograph as the Document Type setting.

If you select this item and click Preview, you can scan by automatically detecting the scan area, direction,
or skew of the document, or place multiple photos on the scanner glass.

5. Click Preview.

Note:
A Depending on the photos and the scanning conditions, the scan results may not be as intended. Clear Thumbnail,
and only place one photo.

(A When placing multiple photos, place them at least 20 mm (0.8 inch) apart. Also, the edge area of the scanner glass is
not scanned.
6. Adjust the quality or brightness of the image as necessary.
Note:
Depending on the originals, the scan results may not be as intended.

7. Click Scan.

8. In the File Save Settings screen, make appropriate settings such as the file name, location, and image format
type, and then click OK.

Note:
When Show this dialog box before next scan is cleared, the File Save Settings screen is not displayed and scanning

starts immediately. To display the File Save Settings screen, click the 4 (File Save Settings) icon to the right of Scan
before starting to scan.

Related Information
= “Placing Originals on the Scanner Glass” on page 35
= “EPSON Scan (Scanner Driver)” on page 127
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Scanning Using Advanced Features

Scanning by Detecting the Original Automatically (Full Auto Mode)

You can start scanning by simply placing the original and clicking Scan. Select Full Auto Mode from the Mode list
in EPSON Scan.

r

R

tode:

i
. EPSON Scan |Fu||.-“-'-.utn:| Mode

To zoan in Full Auto Mode, pogition ar load

g Scan the matenal pou want to zoan, then chick
Scan.

For Color Restaration and ather options, click the

Lustomize... Cuzstomize button and then make the zettings.

Shiow thiz dialag baow before next scan.

@ You can change the zcan mode in the Mode lizt box

at the top right of the window.

Scanning at Specified Sizes (Office Mode)

You can scan originals at the specified size without previewing the image. Select Office Mode from the Mode list in
EPSON Scan.
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Office Mode is not available for Japanese operating systems.

tode:

' Office Mode

Image Type
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Size:
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[ Color Erhance:
Brightness:

Contrast;
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D Breview

g Scan

Help

Canfiguration. ..

93



User's Guide

Scanning

Scanning by Adjusting the Image Quality (Professional Mode)

You can scan images while adjusting the quality and color. This mode is recommended for advanced users. Select
Professional Mode from the Mode list in EPSON Scan.

tode:

o
EF)SO N SCE N | Frofeszional Mode

Settings

M arne: | Curent Setting

Save

Original

D' ocument Tope: | Reflective

D ocurment Source: | Scanner Glazs

Auto Exposure Type: | Phaoto

Destination

Vit Tt ' 24-bit Color

R ezalutian: | 300 W | dpi

Document Size: U 880 H  11.70 in

Target Size: Original

Adjuztmentz

1° I =

.
Unzharp Maszk
[ | Descreening

[ ] Colar Restaration

[ ] Backlight Correction

[ ] Dust Removal

u Ereview ; Sean

[ ] Thumbnai

Help Configuration. ..
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Scanning from Smart Devices

Epson iPrint is an application that allows you to scan photos and documents from a smart device, such as a
smartphone or tablet, that is connected to the same wireless network as your printer. You can save the scanned
data on a smart device or to Cloud services, send it by email, or print it.

Related Information

= “Epson Connect Service” on page 119

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Using Epson iPrint
Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice.

(1] e

seese 7 19:41 2% [ L L] & 19:41 2% -

£ Home Scan 6

Epson iPrint

Save Mail Print

oy
000
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-]

Home screen displayed when the application is started.

®

Displays information on how to setup the printer and a FAQ.

<]

Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

Displays the scanning screen.

Displays the screen where you can make scan settings such as resolution.

Displays scanned images.

Starts scanning.

Displays the screen where you can save scanned data to a smart device or Cloud services.

Displays the screen where you can send scanned data by email.

e 6 06 0o o6 o

Displays the screen where you can print scanned data.
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Replacing Ink Cartridges

Checking the Ink Levels

You can check the approximate ink levels from the control panel or the computer.

Checking the Ink Levels - Control Panel
1. Enter Setup from the home screen.

2. Select Ink Levels.

Checking the Ink Levels - Windows
1. Access the printer driver window.

2. Click Ink Levels on the Main tab.

Note:
If EPSON Status Monitor 3 is disabled, the ink levels are not displayed. Click Extended Settings on the Maintenance
tab, and then select Enable EPSON Status Monitor 3.

Related Information

= “Windows Printer Driver” on page 121

Checking the Ink Levels - Mac OS X

1. Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

Ink Cartridge Codes

Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may
not be displayed.

The following are the codes for genuine Epson ink cartridges.
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Icon BK (Black) C(Cyan) M (Magenta) Y (Yellow) LC (Light Cy- LM (Light
an) Magenta)
Elephant 24 24 24 24 24 24
24XL" 24XL" 24XL" 24XL* 24xL" 24xL"
* "XL" indicates a large cartridge.
Note:
(A Not all cartridges are available in all regions.
(A For users in Europe, visit the following website for information on Epson's ink cartridge yields.
http://www.epson.eu/pageyield
For Australia and New Zealand
BK (Black) C (Cyan) M (Magenta) Y (Yellow) LC (Light Cyan) LM (Light Ma-
genta)
277 277 277 277 277 277
277X 277XL" 277XL" 277XL" 277XL" 277XL"
* "XL" indicates a large cartridge.
Note:

Not all cartridges are available in all regions.

Ink Cartridge Handling Precautions

Read the following instructions before replacing ink cartridges.

Handling precautions

[ Store ink cartridges at normal room temperature and keep them away from direct sunlight.
[d Epson recommends using the ink cartridge before the date printed on the package.

[ For best results, use up ink cartridge within six months of opening the package.

[ For best results, store ink cartridge packages with their bottom down.

[J After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at
least three hours before using it.

(4 Do not open the ink cartridge package until you are ready to install it in the printer. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal
printing may not be possible.
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(d Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

[ Install all ink cartridges; otherwise you cannot print.

4 Do not replace ink cartridges with the power off. Do not move the print head by hand; otherwise, you may
damage the printer.

[d After installing the ink cartridge, the power light continues to flash while the printer is charging ink. Do not
turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

(d Do not leave the printer with the ink cartridges removed or do not turn off the printer during cartridge
replacement.Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

[J Be careful not to let dust or any objects get inside the ink cartridge holder. Anything inside the holder may
adversely affect the printing results or result in an inability to print. If anything gets inside the holder, remove it
carefully.

[ If you remove the cartridge from the printer for later use or to dispose of it, make sure you put the cap back on
the cartridge’s ink supply port to prevent ink from drying out or to prevent surrounding areas from getting
smeared by ink.

[ This printer uses ink cartridges equipped with a green chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the printer before it is
expended, you can still use the cartridge after reinserting it back into the printer. However, when reinserting a
cartridge, some ink may be consumed to guarantee printer performance.

(d For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with
low ink status may not be used when reinserted.

[d To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your printer indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

(4 Although the ink cartridges may contain recycled materials, this does not affect printer function or
performance.

[d Specifications and appearance of the ink cartridge are subject to change without prior notice for improvement.

(d Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
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[J You cannot use the cartridges that came with the printer for the replacement.

[J Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

[ Finish ink cartridge replacement promptly. Do not leave the printer with the ink cartridges removed.

Ink Consumption

[J To maintain optimum print head performance, some ink is consumed from all cartridges not only during
printing but also during maintenance operations such as ink cartridge replacement and print head cleaning.

[ When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the
paper type or print quality settings. This is because a mixture of color inks is used to create black.

(d The ink in the ink cartridges supplied with your printer is partly used during initial setup. In order to produce
high quality printouts, the print head in your printer will be fully charged with ink. This one-off process
consumes a quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink
cartridges.

Replacing Ink Cartridges

A Caution:

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.

g Important:

Finish ink cartridge replacement promptly. Do not leave the printer with the ink cartridges removed.

Note:
[ You can continue printing even after the printer indicates that the ink is low. However, prepare new ink cartridges as soon
as possible.

Q If you replace the ink cartridges while copying, the originals may move out of place. Press the & button to cancel and
replace the originals.

1. Ifthe CD/DVD tray has been inserted, remove the tray.

2. Do one of the following.

(d When prompted to replace ink cartridges

Check which ink cartridge needs to be replaced, touch Proceed, and then select Yes, replace now. Remove
the new ink cartridge from its package.

[d When replacing ink cartridges before they are expended
Enter Setup from the home screen, and then select Maintenance > Ink Cartridge(s) Replacement. Touch

Proceed, remove the new ink cartridge from its package, and then press the <> button.
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3. Make sure the cap is facing up, and then remove it.

n Important:

Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.
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5. Push the tab to unlock the ink cartridge holder, and then remove the cartridge diagonally.

u Important:

If you remove the cartridge from the printer for later use or to dispose of it, make sure you put the cap back on
the cartridge’s ink supply port to prevent ink from drying out or to prevent surrounding areas from getting
smeared by ink.

6. Insert the ink cartridge diagonally into the cartridge holder and gently push it down until it clicks into place.

7. Close the scanner unit, and then press the <> button.
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8. Follow the on-screen instructions.

g Important:

1 After installing the ink cartridge, the power light continues to flash while the printer is charging ink. Do not
turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

1 Do not insert the CD/DVD tray until ink charging is complete.

Related Information
= “Ink Cartridge Codes” on page 97
= “Ink Cartridge Handling Precautions” on page 98

Temporarily Printing with Black Ink

When color ink is expended and black ink still remains when printing from a computer, you can use the following
settings to continue printing for a short time using only black ink.

[d Type of paper: plain papers, Envelope

4 Color: Grayscale

[d Borderless: Not selected

[J EPSON Status Monitor 3: Enabled (for Windows only)

Because this feature is only available for approximately five days, replace the expended ink cartridge as soon as
possible.

Note:
[d IfEPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

(A The available period varies depending on the usage conditions.
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Temporarily Printing with Black Ink - Windows

1. When the following window is displayed, cancel printing.

Color cartridge(s) need to be replaced. Black printing is tempararily available.

Epson recommends the genuine Epson cartridges listed above. Click [Replace Cartridae] for ink
cartridge replacement instructions or dick [Close] to see Status Monitor,

‘fou can cancel the job and temporarily continue printing in black ink with the following settings:
- Paper Type: plain papers or Envelope

- Color: Grayscale

- Borderless: Mot Selected

If it is not printed correctly with the settings above, there may be an error on the previous print
job. Cancel the previous print job on the product and print again.

Replace Cartridge. ..

The settings you selected are not available.

Black printing is temporarily available using the following settings:
- Paper Type: plain papers or Envelope

- Color: Grayscale

- Borderless: Mot Selected

To print with other settings, please replace the expended cartridge(s).

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

2. Access the printer driver window.
3. Clear Borderless on the Main tab.

4. Select plain papers or Envelope as the Paper Type setting on the Main tab.
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5. Select Grayscale.
6. Set the other items on the Main and More Options tabs as necessary, and then click OK.
7. Click Print.

8. Click Print in Black in the window displayed.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Printing Basics - Windows” on page 55

Temporarily Printing with Black Ink - Mac OS X

Note:
To use this feature through a network, connect with Bonjour.

1. Click the printer icon in the Dock.

2. Cancel the job.

Note:
If you cannot cancel printing from the computer, cancel using the printer's control panel.

3. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver).

4. Select On as the Permit temporary black printing setting.

5. Access the print dialog.

6. Select Print Settings from the pop-up menu.

7. Select any paper size except for a borderless size as the Paper Size setting.
8. Select plain papers or Envelope as the Media Type setting.

9. Select Grayscale.

10. Set the other items as necessary.

11. Click Print.

Related Information

= “Canceling Printing” on page 79

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
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= “Printing Basics - Mac OS X” on page 56

Conserving Black Ink when the Black Ink Is Low (for
Windows Only)

When black ink is running low and there is enough color ink remaining, you can use a mixture of color inks to
create black. You can continue printing while preparing a replacement black ink cartridge.

This feature is only available when you select the following settings in the printer driver.
(d Paper Type: plain papers

([ Quality: Standard

[d EPSON Status Monitor 3: Enabled

Note:
[d If EPSON Status Monitor 3 is disabled, access the printer driver, click Extended Settings on the Maintenance tab, and
then select Enable EPSON Status Monitor 3.

1 Composite black looks slightly different from pure black. In addition, the print speed is reduced.

1 To maintain the quality of the print head, black ink is also consumed.

EPSON Status Monitor 3

Black ink is low. You can extend black ink cartridge life by printing with a
mixture of other colors to create composite black.
Do you want to do this for the current print job?

Yes

Mo

Disable this feature

Options Description

Yes Select to use a mixture of color inks to create black. This window is displayed the next time
you print a similar job.

No Select to continue using the remaining black ink. This window is displayed the next time
you print a similar job.

Disable this feature Select to continue using the remaining black ink. This window is not displayed until you
replace the black ink cartridge and it runs low again.
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Maintaining the Printer

Checking and Cleaning the Print Head

If the nozzles are clogged, the printouts become faint, there is visible banding, or unexpected colors appear. When
print quality has declined, use the nozzle check feature and check if the nozzles are clogged. If the nozzles are
clogged, clean the print head.

g Important:

Do not open the scanner unit or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

Note:
[d Because print head cleaning uses some ink, clean the print head only if quality declines.

[d When ink is low, you may not be able to clean the print head. Replace the ink cartridge first.

1 If print quality has not improved after repeating nozzle check and head cleaning about two times, wait for at least six
hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary. We recommend to
turn off the printer. If print quality has still not improved, contact Epson support.

(A To prevent the print head from drying out, always turn the printer off by pressing the O button.

[ To keep the print head operating at its best, we recommend printing a few pages on a regular basis.

Checking and Cleaning the Print Head - Control Panel
1. Load A4-size plain paper in the paper cassette.

2. Enter Setup from the home screen.

3. Select Maintenance > Nozzle Check.

4. Follow the on-screen instructions to print the nozzle check pattern.

5. Compare the printed check pattern with the sample shown below.

(d All lines are printed: The print head nozzles are not clogged. Select Done.
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[d There are broken lines or missing segments: The print head nozzles may be clogged. Go to the next step.

Note:
The test pattern may vary by model.

Select Clean the Print Head.
Follow the on-screen instructions to clean the print head.
When cleaning is finished, select Print Nozzle Check Pattern, and then follow the on-screen instructions to

print the nozzle check pattern again. Repeat cleaning and printing the pattern until all lines are printed
completely.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

Checking and Cleaning the Print Head - Windows

1.

Load A4-size plain paper in the paper cassette.
Access the printer driver window.
Click Nozzle Check on the Maintenance tab.

Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

= “Windows Printer Driver” on page 121

Checking and Cleaning the Print Head - Mac OS X

1.

Load A4-size plain paper in the paper cassette.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Nozzle Check.

Follow the on-screen instructions.
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Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

Aligning the Print Head

If you notice a misalignment of vertical lines or blurred images, align the print head.

Aligning the Print Head - Control Panel

1. Load A4-size plain paper in the paper cassette.

2. Enter Setup from the home screen.

3. Select Maintenance > Print Head Alignment.

4. Follow the on-screen instructions to print the alignment pattern.

5. Follow the on-screen instructions to align the print head. Find and select the number for the most solid
pattern in each group using the — or + button.

#1

Note:
(A The test pattern may vary by model.

1 If print quality is not improved, align the print head from a computer.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

Aligning the Print Head - Windows
1. Load A4-size plain paper in the paper cassette.

2. Access the printer driver window.

3. Click Print Head Alignment on the Maintenance tab.

4. TFollow the on-screen instructions.
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Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

= “Windows Printer Driver” on page 121

Aligning the Print Head - Mac OS X

1.

Load A4-size plain paper in the paper cassette.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

Click Options & Supplies > Utility > Open Printer Utility.
Click Print Head Alignment.

Follow the on-screen instructions.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

Cleaning the Paper Path

When the printouts are smeared or scuffed, clean the roller inside. You cannot use the cleaning sheet that came
with Epson paper.

n Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

Make sure there is no dust or stains on the scanner glass and the document cover.
Load A4-size plain paper in the paper cassette.

Start copying without placing an original on the scanner glass.

Note:
Repeat this procedure until the paper is not smeared with ink. If you are using the rear paper feed slot, load A4-size (or
A3-size) plain paper after starting to copy.

Related Information

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

= “Copying Basics” on page 80

Cleaning the Scanner Glass

When the copies or scanned images are smeared or scuffed, clean the scanner glass.
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n Important:

Never use alcohol or thinner to clean the printer. These chemicals can damage the printer.

1. Open the document cover.

2. Use a soft, dry, clean cloth to clean the surface of the scanner glass.

Note:
(A If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass cleaner
and a soft cloth to remove it. Wipe off all remaining liquid.

[d Do not press the glass surface too hard.

[ Be careful not to scratch or damage the surface of the glass. A damaged glass surface can decrease the scan quality.

Saving Power

The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the printer's energy efficiency. Please
consider the environment before making any change.

Saving the Power - Control Panel
1. Enter Setup from the home screen.

2. Select Printer Setup.

3. Select Power Off Timer or Sleep Timer.

4. Select the setting.

Saving Power - Windows
1. Access the printer driver window.
2. Click Printer and Option Information on the Maintenance tab.

3. Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Send. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click Send.

4. Click OK.
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Saving Power - Mac OS X

1. Select System Preferences from the i menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.
3. Click Printer Settings.

4. Select the time period before the printer enters sleep mode as the Sleep Timer setting, and click Apply. To
make the printer turn off automatically, select the time period as the Power Off Timer setting, and click

Apply.
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Menu Options for Setup Mode

By selecting Setup on the home screen from the control panel, you can make printer settings or perform printer
maintenance.

Menu Options for Ink Levels

Select the menus on the control panel as described below.

Setup > Ink Levels

Displays the approximate levels of the ink cartridges. When an ! icon is displayed, the ink cartridge is running low.
When a X mark is displayed, the ink cartridge is expended.

Menu Options for Maintenance

Select the menus on the control panel as described below.

Setup > Maintenance

Nozzle Check

Prints a pattern to check if the print head nozzles are clogged.

Head Cleaning

Cleans clogged nozzles in the print head.

Print Head Alignment
Adjusts the print head to improve print quality.

Ink Cartridge(s) Replacement

Use this feature to replace the ink cartridges before the ink is expended.

Related Information
® “Checking and Cleaning the Print Head” on page 107
= “Aligning the Print Head” on page 109

Menu Options for Printer Setup

Select the menus on the control panel as described below.

Setup > Printer Setup

Paper Source Setting
(4 Paper Setup

Select the paper size and paper type you loaded in the paper source.
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[d Paper Configuration

Automatically displays the paper settings screen when paper is loaded. Disable this feature if you
always load the same size of paper and you do not want to make paper settings every time you load
paper. AirPrint is not available when this is disabled. Also, the printer does not warn you even if the
paper settings do not match the paper you loaded.

CD/DVD
Adjusts the printing position of a CD/DVD by moving up, down, left, or right to fit.

Stickers
Adjusts the printing position of a photo sticker by moving up, down, left, or right to fit.

Thick Paper

Use this feature if ink smears and the paper gets dirty. When enabled, the printing speed may be slower.
Only enable this setting when ink smears. This feature is disabled when the power is turned off.

Sound

Adjusts the volume and turns sound on or off when you press buttons or an error occurs.

Quiet Mode

Reduces the noise the printer makes, however, this may reduce print speed. Depending on the paper
type and print quality settings you selected, there may be no difference in the printer's noise level.

Screen Saver

By selecting Memory Card Data, photos are displayed sequentially when no operations are performed
for about three minutes.

Auto Power On

Turns on the printer automatically when it receives a print or scan job by USB-connection or a network
connection. Use the Power Off Timer setting if you want the printer to automatically turn off when the
job is finished and a set time period has passed with no operations performed. This is useful when
printing from a remote location such as over the Internet. However, enabling Auto Power On increases
power consumption slightly in standby status when compared to turning the printer off completely.

Power Off Timer

Automatically turns the printer off if no operations are performed for a set time period. You can adjust
the time before power management is applied. Any increase will affect the printer’s energy efficiency.
Please consider the environment before making any change.

Sleep Timer

Select the time period before the printer enters sleep mode (energy saving mode) when no operations
are performed. The LCD screen turns black when the set time passes.

Clear All Settings
Resets the settings in Printer Setup to their defaults.
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Menu Options for Basic Setup

Select the menus on the control panel as described below.

Setup > Basic Setup

Language
Select the display language.

Menu Options for Network Settings

Select the menus on the control panel as described below.

Setup > Network Settings

Network Status

Displays or prints the network settings and connection status.

Wi-Fi Setup
See the Network Guide to make the following settings.

[ Wi-Fi Setup Wizard

Select a SSID, enter a password, and then connect the printer to a wireless (Wi-Fi) network.

(d Push Button Setup (WPS)

Connects the printer to a wireless (Wi-Fi) network by pressing a WPS push button on a wireless
router.

(4 PIN Code Setup (WPS)

In the wireless router utility, enter the PIN code displayed on the printer's screen to connect the
printer to a wireless (Wi-Fi) network.

1 Wi-Fi Auto Connect

Connects the printer to a wireless (Wi-Fi) network using a computer that is connected to the access

point. Insert the software disc supplied with the printer into the computer, and then follow the on-
screen instructions. When you are prompted to operate the printer, run this menu.

[ Disable Wi-Fi

Disables the connection by turning off the wireless signal without deleting the network information.

To enable the connection, set up the wireless (Wi-Fi) network again.

[ Wi-Fi Direct Setup

Connects the printer to a wireless (Wi-Fi) network without a wireless router.

Manual Network Setup

Changes the network settings, such as the printer name or TCP/IP. See the Network Guide for more
details.

Network Connection Check
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Checks the status of the network connection and prints the network connection check report. If there
are any problems with the connection, see the check report to solve the problem. See the Network Guide
for more details.

Menu Options for Epson Connect Services

Select the menus on the control panel as described below.

Setup > Epson Connect Services

Status

Check whether or not the printer is registered and connected to the Epson Connect services.

Email Address

Check the printer's email address that is registered to the Epson Connect services.

Register/Delete

Register or delete the printer to or from the Epson Connect services.

Suspend/Resume

Select whether to suspend or resume Epson Connect services.

Menu Options for Google Cloud Print Services

Select the menus on the control panel as described below.

Setup > Google Cloud Print Services

Status

Check whether or not the printer is registered and connected to the Google Cloud Print services.

Suspend/Resume

Select whether to suspend or resume Google Cloud Print services.

Restore Default Settings
Resets the settings to their defaults.

Menu Options for File Sharing Setup

Select the menus on the control panel as described below.
Setup > File Sharing Setup
Select the connection method between the printer and a computer that will have write access to the memory card

inserted in the printer. Read and write access is given to the computer with the priority connection. Only read
access is given to other computers.
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Related Information

= “Accessing a Memory Card From a Computer” on page 164

Menu Options for Home NW Print Settings

Select the menus on the control panel as described below.

Setup > Home NW Print Settings

Make print settings for printing from an external device that is connected to a home network.

Related Information

= “Menu Options for Printing from the Control Panel” on page 51

Menu Options for External Device Setup

Select the menus on the control panel as described below.

Setup > External Device Setup

Change the print settings to print directly from an external device such as a digital camera. For explanations on
each setting item, see the descriptions of the menu options for printing from the control panel.

Related Information

= “Menu Options for Printing from the Control Panel” on page 51

Menu Options for Guide Functions

Select the menus on the control panel as described below.

Setup > Guide Functions

Paper Setting Alert

Displays a warning if the paper settings (print settings) for the print job do not match the printer's
paper settings made when you loaded the paper. This setting prevents misprinting. However, the paper
setting screen is not displayed when Paper Configuration is disables in the following menus.

Setup > Printer Setup > Paper Source Setting

Document Alert

Displays a warning when an original has been left on the scanner glass when the document cover is not
open even though copying and scanning using the control panel is complete.

Auto Selection Mode

When any of the following operations are performed, the menus appropriate to the operation are
displayed.

[d A memory card is inserted.
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[J An original is placed on the scanner glass.

All Functions

Enables or disables all guidance functions.

Clear All Settings

Resets the Guide Functions settings to their defaults.

Menu Options for Firmware Update

Select the menus on the control panel as described below.

Setup > Firmware Update

Update

Checks if the latest version of the firmware has been uploaded to the network server. If an update is
available, you can select whether or not to start updating.

Current Version

Displays the current firmware version of your printer.

Notification

Checks for firmware updates periodically and notifies you if an update is available.

Related Information

= “Updating the Printer's Firmware using the Control Panel” on page 132

Menu Options for Restore Default Settings

Select the menus on the control panel as described below.

Setup > Restore Default Settings

Network Settings

Resets the network settings to their defaults.

All Except Network Settings

Resets all settings except for network settings to their defaults.

All Settings
Resets all settings to their defaults.
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Network Service and Software
Information

This section introduces the network services and software products available for your printer from the Epson
website or the supplied CD.

Epson Connect Service

By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere.

The features available on the Internet are as follows.

Email Print Epson iPrint remote print Scan to Cloud Remote Print Driver

v/ 4 4 4

See the Epson Connect portal website for details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Web Config

Web Config is an application that runs in a web browser, such as Internet Explorer and Chrome, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

Note:
The following browsers are supported.
0s Browser
Windows XP or later Internet Explorer 8 or later, Firefox”, Chrome”
Mac OS X v10.6.8 or later Safari”, Firefox”, Chrome”
i0s” Safari®
Android 2.3 or later Default browser
Chrome OS” Default browser

*. Use the latest version.
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Running Web Config on a Web Browser

1. Check the printer's IP address.

——— —

r—

s 2

I:‘l

Press the network icon (for example ) from the home screen, and then press See Connection
Details. Check the printer's IP address on the screen displayed.
2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.
Format:
IPv4: http://the printer's IP address/
IPv6: http://[the printer's IP address]/
Examples:
IPv4: http://192.168.100.201/
IPv6: http://[2001:db8::1000:1]/

Note:
Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

= “Using Epson iPrint” on page 74

Running Web Config on Windows
When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Access the devices and printers screen in Windows.
(d Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

1 Windows 7
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.
1 Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound.
2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Running Web Config on Mac OS X

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies> Show Printer Webpage.
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Windows Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.

Note:
You can change the language of the printer driver. Select the language you want to use from the Language setting on the
Maintenance tab.

Accessing the printer driver from applications
To make settings that apply only to the application you are using, access from that application.
Select Print or Print Setup from the File menu. Select your printer, and then click Preferences or Properties.

Note:
Operations differ depending on the application. See the application’s help for details.

Accessing the printer driver from the control panel
To make settings that apply to all of the applications, access from the control panel.

[d Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

J Windows 7

Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

[J Windows Vista

Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Printing preferences.

J Windows XP

Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar
The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Guide to Windows Printer Driver

Help is available in the printer driver for Windows. To view explanations of the setting items, right-click on each
item, and then click Help.

Main Tab

You can make basic settings for printing, such as paper type or paper size.

121



User's Guide

You can also make settings for printing both sides of the paper or printing multiple pages on one sheet.

Network Service and Software Information

Main | More Options | Mairtenance |

Printing Presets

| Add/Remove Presets...

EI Document - Fast

=] Document - Standard Quality
ﬁ Document - High Quality

£l Document - 2-Sided

E| Document - A3

£ Photo - 10 x 15 cm Portrait
s Photo - 10 x 15 cm Landscape
(=) Printable CO/DVD Printing

£ Photo - A4 Portrait

ws Photo - A4 Landscape

Paper Source

Document Size

Orientation

Paper Type
Quality

Color

| Auto

| A4 210 x 297 mm

[IBorderless
(®) Portrait

Settings...
(") Landscape

|rialr: papers

|513ndard

(@) Color

() Grayscale

g

2Sided Printing | Off

Multi-Page

Off Page Order...

Copies.

Iil Collate

[]reverse Order

Show Settings

| ResetDefaults | |

Ink Levels

Quiet Mode
[ Print Preview

[ 70b Arranger Lite
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More Options Tab

You can select additional layout and printing options such as changing the size of a printout or making color

corrections.

m Mere Options | Maintenance

Printing Presets

| Add/Remove Presets. ..

EI Document - Fast

EI Document - Standard Quality
28 Document - High Quality

ﬁ Document - 2-Sided

£ Photo - 10 x 15 am Portrait
s Photo - 10 x 15 cm Landscape
£ Photo - A4 Portrait

ws Photo - A4 Landscape

Document Size | A4 210 x 297 mm

Output Paper | Same as Document Size

[ JReduce/Enlarge Document
(_JFit to Page ) Zoom to

D Center

Color Correction
(®) Automatic

Advanced...

Image Options...

(") Custom

| Watermark Features... |

Additional Settings
[Jrotate 180°
High Speed
|:| Mirror Image
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Maintenance Tab

You can run maintenance features such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor 3, you can check printer status and error information.

= Printing Preferences “

@ Mozzle Check @I EPSON Status Monitor 3
= [
ﬁ“» Head Cleaning @i Monitoring Preferences

8 | Print Head Alignment

Extended Settings

@

7

‘ I Job Arranger Lite %l Printer and Option Information
|@§1§tware Update |
I- Online Order |

Version X.XX. XX e e |
| Technical Support |

oK || cancel |[ Hep |

Making Operation Settings for the Windows Printer Driver

You can make settings such as enabling EPSON Status Monitor 3.
1. Access the printer driver window.
2. Click Extended Settings on the Maintenance tab.

3. Make the appropriate settings, and then click OK.

See the online help for explanations of the setting items.

Related Information

= “Windows Printer Driver” on page 121

Mac OS X Printer Driver

The printer driver controls the printer according to the commands from an application. Making settings on the
printer driver provides the best printing results. You can also check the status of the printer or keep it in top
operating condition using the printer driver utility.
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Accessing the printer driver from applications

Click Page Setup or Print on the File menu of your application. If necessary, click Show Details (or ¥) to expand
the print window.

Note:
Depending on the application being used, Page Setup may not be displayed in the File menu, and the operations for
displaying the print screen may differ. See the application's help for details.

Starting the utility

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Utility > Open Printer Utility.

Guide to Mac OS X Printer Driver

Print dialog

Switch the pop-up menu on the center of the screen to show more items.

Printer:  EPSON XXXX [V
Presets: Default Settings [ 7]
Copies: 1
Pages: © All
From: 1 to: (1
Paper Size: A4 210 by 297 mm

Orientation: Ti' LIFS

TextEdit | <]

Print header and footer
Rewrap contents to fit page

Cancel ' SIS

Pop-up Menu Descriptions

Print Settings You can make the basic print settings such as paper type and print quality.

Two-sided Printing You can select a binding direction for 2-sided printing or select a document type.

Settings

Layout You can select a layout for printing several pages on one sheet or select to print a border.

Paper Handling You can reduce or enlarge the size of the print job to automatically fit the paper size you
loaded.

Color Matching You can adjust the colors.

Color Options When you select EPSON Color Controls from the Color Matching menu, you can select a
color correction method.

125



User's Guide

Network Service and Software Information

Note:
On Mac OS X v10.8.x or later, if Print Settings menu is not displayed, Epson printer driver has not been installed correctly.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer,
and then add the printer again. See the following to add a printer.

http://epson.sn

Epson Printer Utility

You can run a maintenance feature such as nozzle check and print head cleaning, and by starting EPSON Status
Monitor, you can check printer status and error information.

@ Epson Printer Utility 4

RFEmIA D ZRA
EPSON Epson xxxx

HRITEEY,

IR— 32 0 (xa00)

O #EH

n AA

EPSONFU&— A ZNFud AYEZU—Z Fry THE
1w kS
B s 4 Ty —EE

Making Operation Settings for the Mac OS X Printer Driver

Accessing the Operation Settings Window of the Mac OS X Printer Driver

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS X Printer Driver

(d Thick paper and envelopes: Prevents the ink from smearing when printing on thick paper. However, this may
reduce print speed.

[ Skip Blank Page: Avoids printing blank pages.

d Quiet Mode: Reduces the noise the printer makes, however, may reduce print speed.

(d Permit temporary black printing: Prints only with black ink temporarily.

[d Automatic Cassette Switching: Automatically feeds paper from paper cassette 2 when paper run out in paper
cassette 1.
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[J High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

[J Warning Notifications: Allows the printer driver to display warning notifications.

[ Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.

Related Information

= “Temporarily Printing with Black Ink” on page 103

EPSON Scan (Scanner Driver)

EPSON Scan is an application for controlling scanning. You can adjust the size, resolution, brightness, contrast,
and quality of the scanned image.

Note:
You can also start EPSON Scan from a TWAIN-compliant scanning application.

Starting on Windows
[ Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

(4 Except for Windows 8.1/Windows 8
Click the start button, and select All Programs or Programs > EPSON > EPSON Scan > EPSON Scan.

Starting on Mac OS X

Note:
EPSON Scan does not support the Mac OS X fast user switching feature. Turn off fast user switching.

Select Go > Applications > Epson Software > EPSON Scan.

Epson Event Manager

Epson Event Manager is an application that allows you to manage scanning from the control panel and save images
to a computer. You can add your own settings as presets, such as the document type, the save folder location, and
the image format. See the application's help for details.

Starting on Windows
[J Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[J Except for Windows 8.1/Windows 8

Click the start button, and select All Programs or Programs > Epson Software > Event Manager.

Starting on Mac OS X

Select Go > Applications > Epson Software > Event Manager.
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Related Information

= “Scanning to a Computer” on page 88

Epson Easy Photo Print

Epson Easy Photo Print is an application that allows you to easily print photos with various layouts. You can
preview the photo image and adjust the images or position. You can also print photos with a frame. See the
application's help for details.

Note:
To use this application, the printer driver needs to be installed.

Starting on Windows
[ Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

(4 Except for Windows 8.1/Windows 8

Click the start button, and then select All Programs or Programs > Epson Software > Epson Easy Photo
Print.

Starting on Mac OS X
Select Go > Applications > Epson Software > Epson Easy Photo Print.

Epson Print CD

Epson Print CD is an application that allows you to design a CD/DVD label to be printed directly onto a CD/DVD.
You can also print a CD/DVD jacket for CD/DVD case. See the application's help for details.

Note:
To use this application, the printer driver needs to be installed.

Starting on Windows

[ Windows 8/Windows 8.1

Enter the application name in the search charm, and then select the displayed icon.

[d Except for Windows 8/Windows 8.1

Click the start button, and then select All Programs or Programs > Epson Software > Print CD.

Starting on Mac OS X
Select Go-Applications > Epson Software > Print CD > Print CD.

E-Web Print (for Windows Only)

E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.
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Starting
When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Easy Photo Scan

Easy Photo Scan is an application that allows you to scan photos and easily send the scanned image to a computer
or cloud service. You can also easily adjust the scanned image. See the application's help for details.

Note:
To use this application, the scanner driver EPSON Scan needs to be installed.

Starting on Windows
[ Windows 8.1/Windows 8

Enter the application name in the search charm, and then select the displayed icon.

[J Except for Windows 8.1/Windows 8

Click the start button, and select All Programs or Programs > Epson Software > Easy Photo Scan.

Starting on Mac OS X

Select Go > Applications > Epson Software > Easy Photo Scan.

EPSON Software Updater

EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.

Starting on Windows
(d Windows 8.1/Windows 8
Enter the application name in the search charm, and then select the displayed icon.
(d Except for Windows 8.1/Windows 8
Click the start button, and select All Programs or Programs > Epson Software > EPSON Software Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS X
Select Go > Applications > Epson Software > EPSON Software Updater.

Uninstalling Applications

Note:
Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.
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Uninstalling Applications - Windows

1. Press the ) button to turn off the printer.
2. Quit all running applications.

3. Open Control Panel:

[ Windows 8.1/Windows 8
Select Desktop > Settings > Control Panel.

(d Except for Windows 8.1/Windows 8
Click the start button and select Control Panel.

4. Open Uninstall a program (or Add or Remove Programs):
d Windows 8.1/Windows 8/Windows 7/Windows Vista

Select Uninstall a program in Programs.

4 Windows XP
Click Add or Remove Programs.

5. Select the application you want to uninstall.

6. Uninstall the applications:

[ Windows 8.1/Windows 8/Windows 7/Windows Vista
Click Uninstall/Change or Uninstall.

J Windows XP

Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

7. Follow the on-screen instructions.

Uninstalling Applications - Mac OS X

1. Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

2. Press the ) button to turn off the printer.

3. To uninstall the printer driver, select System Preferences from the " menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

4.  Quit all running applications.

5. Select Go > Applications > Epson Software > Uninstaller.
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6. Select the application you want to uninstall, and then click Uninstall.

n Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.

Note:

If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Related Information
= “EPSON Software Updater” on page 129

Installing Applications

Connect your computer to the network and install the latest version of applications from the website.

Note:
[ Log on to your computer as an administrator. Enter the administrator password if the computer prompts you.

A When reinstalling an application, you need to uninstall it first.
1. Quit all running applications.

2. When installing the printer driver or EPSON Scan, disconnect the printer and the computer temporarily.
Note:
Do not connect the printer and the computer until you are instructed to do so.

3. Install the applications by following the instructions on the website below.
http://epson.sn

Note:
If you are using a Windows computer and you cannot download applications from the website, install them from the
software disc that came with the printer.

Related Information

= “Uninstalling Applications” on page 129

Updating Applications and Firmware

You may be able to clear certain problems and improve or add functions by updating the applications and the
firmware. Make sure you use the latest version of the applications and firmware.

1. Make sure that the printer and the computer are connected, and the computer is connected to the internet.
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Start EPSON Software Updater, and update the applications or the firmware.

g Important:

Do not turn off the computer or the printer while updating.

Note:

If you cannot find the application you want to update in the list, you cannot update using the EPSON Software
Updater. Check for the latest versions of the applications from your local Epson website.

http://www.epson.com

Related Information
= “EPSON Software Updater” on page 129

Updating the Printer's Firmware using the Control Panel

If the printer is connected to the Internet, you can update the printer's firmware using the control panel. By
updating the firmware, the printer's performance may improve, or new functions may be added. You can also set
the printer to regularly check for firmware updates and notify you if any are available.

1.

Enter Setup from the home screen.

Select Firmware Update > Update.

Note:
Select Notification > On to set the printer to regularly check for available firmware updates.

Press Proceed. The printer starts searching for available updates.

If a message is displayed on the LCD screen informing you that a firmware update is available, follow the on-
screen instructions to start the update.

n Important:

(A Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.

[ If the firmware update is not completed or is unsuccessful, the printer does not start up normally and
"Recovery Mode" is displayed on the LCD screen the next time the printer is turned on. In this situation, you
need to update the firmware again using a computer. Connect the printer to the computer with a USB cable.
While "Recovery Mode" is displayed on the printer, you cannot update the firmware over a network
connection. On the computer, access your local Epson website, and then download the latest printer

firmware. See the instructions on the website for the next steps.

Related Information

= “Technical Support Web Site” on page 165
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Checking the Printer Status

Checking Messages on the LCD Screen

If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to

solve the problem.

Error Messages

Solutions

Printer error. Turn the power off and on again.
For details, see your documentation.

If the error message is still displayed after turning the power off and on
again, contact Epson support.

Operation canceled. An error occurred while
saving.

The external storage device, such as a memory card, may be damaged.
Check if the device is available.

Ink is low.

You can continue printing until you are prompted to replace the ink
cartridges. However, note that the printer cannot print if any of the ink
cartridges is expended. Prepare new cartridges as soon as possible.

You need to replace the following ink
cartridge(s).

To ensure you receive premium print quality and to help protect your
print head, a variable ink safety reserve remains in the cartridge when
your printer indicates it is time to replace the cartridge. Replace the
cartridge when you are prompted to do so.

Ink cartridge(s) are low. Print job may not print
completely.

Press Proceed on the error message screen to select one of the
following options.

Replace before printing
Continue printing
Cancel printing

If any of the ink cartridges is expended during printing, the paper is
ejected in the middle of printing. When printing on paper larger than A4
size, we recommend selecting Replace before printing and replacing
the ink cartridge with a new one. We strongly recommend replacing
with a large size Epson ink cartridge.

Paper Configuration is disabled. Some features
may not be available. For details, see your
documentation.

If Paper Configuration is disabled, you cannot use AirPrint. In addition,
messages notifying you that the paper size and type do not match are
not displayed. Keep this setting enabled unless you always use the same
size and type of paper and do not need to change the paper settings.

The printer's ink pad is nearing the end of its
service life. Please contact Epson Support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part. The message will be displayed
until the ink pad is replaced.

Press the <> button to resume printing.

The printer's ink pad is at the end of its service
life. Please contact Epson Support.

Contact Epson or an authorised Epson service provider to replace the
ink pad*. It is not a user-serviceable part.

Communication error. Check if a computer is
connected.

Connect the computer and the printer correctly. If you are connecting
over a network, see the Network Guide. If the error message is still
displayed, make sure that EPSON Scan and Epson Event Manager are
installed on the computer.

133




User's Guide

Solving Problems

Error Messages Solutions

Combination of the IP address and the subnet See the Network Guide.
mask is invalid. See your documentation.

Update the root certificate to use cloud services. Run Web Config, and then update the root certificate.

Recovery Mode The printer has started in recovery mode because the firmware update
failed. Follow the steps below to try to update the firmware again.

1. Connect the computer and the printer with a USB cable. (During
recovery mode, you cannot update the firmware over a network
connection.)

2. Download the latest firmware from the Epson website and start to
update the firmware of your printer.

For details, see the instructions on how to update on the download
page.

* In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage
from the pad, the printer is designed to stop printing when the pad has reached its limit. Whether and how often
this is required will vary according to the number of pages you print, the type of material that you print and the
number of cleaning cycles that the printer performs. The need for replacement of the pad does not mean that your
printer has ceased to operate in accordance with its specifications. The printer will advise you when the pad
requires replacing and this can only be performed by an authorised Epson Service provider. The Epson warranty
does not cover the cost of this replacement.

Related Information

= “Contacting Epson Support” on page 166

= “Supported Memory Card Specifications” on page 158

= “Supported External Storage Device Specifications” on page 159
= “Installing Applications” on page 131

=» “Web Config” on page 119

= “Updating Applications and Firmware” on page 131

Checking the Printer Status - Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab.

Note:

[ You can also check the printer status by double-clicking the printer icon on the taskbar. If the printer icon is not
added to the taskbar, click Monitoring Preferences on the Maintenance tab, and then select Register the shortcut
icon to the taskbar.

(4 If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

= “Windows Printer Driver” on page 121
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Checking Printer Status - Mac OS X

1. Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

Removing Jammed Paper

Check the error displayed on the control panel and follow the instructions to remove the jammed paper including
any torn pieces. Next, clear the error.

g Important:

Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

Removing Jammed Paper from the Paper Cassette

/2
e
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1. Close the output tray.

2. Pull out the paper cassette.

3. Remove the jammed paper.
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4. Align the edges of the paper and slide the edge guides to the edges of the paper.

RS

5. Insert the paper cassette in the printer.

Removing Jammed Paper from Inside the Printer

A Caution:

[ Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be
injured.

[d Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating,
it could cause an injury. Be careful not to touch the protruding parts to avoid injury.

1. Open the scanner unit with the document cover closed.

2. Remove the jammed paper.
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n Important:

Do not touch the white flat cable or translucent part inside the printer. Doing so may cause a malfunction.

3. Close the scanner unit.

Removing Jammed Paper from the Rear Cover

1. Remove the rear cover.
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2. Remove the jammed paper.

3. Remove jammed paper from the rear cover.

4. Open the cover of the rear cover.

5. Remove the jammed paper.
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6. Close the cover of the rear cover, and then insert the rear cover in the printer.

Paper Does Not Feed Correctly

Check the following points, and then take the appropriate actions to solve the problem.

[ Place the printer on a flat surface and operate in the recommended environmental conditions.
[d Use paper supported by this printer.

(4 Follow the paper handling precautions.

[d Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

Related Information

= “Environmental Specifications” on page 160
= “Paper Handling Precautions” on page 21

= “Available Paper and Capacities” on page 22
= “List of Paper Types” on page 23

Paper Jams

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d Load one sheet of paper at a time if you have loaded several sheets of paper.

Related Information

= “Removing Jammed Paper” on page 135

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

Paper Feeds at a Slant

Load paper in the correct direction, and slide the edge guides against the edges of the paper.
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Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31

Several Sheets of Paper are Fed at a Time

(d Load one sheet of paper at a time.

[d When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is
loaded in the printer before you reload the paper.

No Paper Feeds

Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load above
the line indicated by the triangle symbol on the edge guide.

Related Information

= “Available Paper and Capacities” on page 22

Paper is Ejected from the Rear Paper Feed Slot Without Being
Printed

If you load paper before the rear paper feed slot is ready, the paper is ejected without being printed. Send the print
job first, and then load paper when the printer prompts you to do so.

CD/DVD Tray is Ejected

[d Make sure the disc is properly set on the tray and reinsert the tray correctly.

[d Do not insert the CD/DVD tray until you are instructed to do so. Otherwise, an error occurs and the tray is
ejected.

Related Information
= “Loading a CD/DVD” on page 39

Power and Control Panel Problems

Power Does Not Turn On

0 Hold down the O button for a lttle longer.

[d Make sure the power cord is securely plugged in.
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Lights Came On and then Went Out

The printer's voltage may not match the outlet rating. Turn off the printer and unplug it immediately. Then check
the label on the printer.

A Caution:

If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact your dealer.

Power Does Not Turn Off

Hold down the O button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the O button.

LCD Screen Gets Dark

The printer is in sleep mode. Press anywhere on the LCD screen to return it to its former state.

The Auto Power On Feature does not Work

[d Make sure that the Auto Power On setting in Setup mode has been enabled.
[d Make sure that the printer is properly connected with a USB cable or to a network.

Related Information

= “Menu Options for Printer Setup” on page 113

Cannot Print from a Computer

[ Install the printer driver.

[d Connect the USB cable securely to the printer and the computer.

[ If you are using a USB hub, try to connect the printer directly to the computer.
(1 If you cannot print over a network, see the Network Guide.

[ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.
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(4 In Windows, click Print Queue on the printer driver's Maintenance tab, and then check the following.
[d Check if there are any paused print jobs.
Cancel printing if necessary.
[ Make sure the printer is not offline or pending.
If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

[J Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark
on the menu item).

If the printer is not selected as the default printer, set it as the default printer.

[J Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

(d In Mac OS X, make sure the printer status is not Pause.

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).

Related Information
= “Installing Applications” on page 131
= “Canceling Printing” on page 79

Cannot Use AirPrint

(A In the Printer Setup > Paper Source Setting menu on the control panel, enable Paper Configuration.

(d Enable the AirPrint setting on Web Config.

Related Information

= “Menu Options for Printer Setup” on page 113
= “Web Config” on page 119

Printout Problems

Nothing or a Very Faint Image is Printed

If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be
discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

Related Information

= “Checking and Cleaning the Print Head” on page 107

Print Quality is Poor

Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors,
misalignment, and mosaic-like patterns in the prints.
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[d Use paper supported by this printer.

[ Select the appropriate paper type setting for the type of paper loaded in the printer.

(d Do not print on paper that is damp, damaged, or too old.

[ If the paper is curled or the envelope is puffed up, flatten it.

[d Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.
(d Align the print head.

(d Print using a higher quality setting.

(4 Do not stack the paper immediately after printing.

[ Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

(d When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

[d Try to use genuine Epson ink cartridges. This product is designed to adjust colors based on the use of genuine
Epson ink cartridges. The use of non-genuine ink cartridges may cause print quality to decline.

[d Epson recommends using the ink cartridge before the date printed on the package.
[ For best results, use up ink cartridge within six months of opening the package.

[ When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Related Information

= “Available Paper and Capacities” on page 22

= “List of Paper Types” on page 23

= “Paper Handling Precautions” on page 21

= “Checking and Cleaning the Print Head” on page 107
= “Aligning the Print Head” on page 109

Print Quality Does Not Improve Even After Aligning the Print Head

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical
lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting.
Disabling this setting may slow down printing speed.

(d Control panel

Disable Bidirectional in the print settings.
d Windows

Clear High Speed on the printer driver’s More Options tab.
d MacOSX

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing
setting.

Related Information

= “Menu Options for Paper and Print Settings” on page 53
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Images or Photos are Printed in Unexpected Colors

The Epson auto photo adjustment setting (PhotoEnhance) is applied by default. Try change the setting.

(d Control panel

Change the Enhance setting from Auto to People, Night Scene, or Landscape. If changing the setting does not
work, turn off PhotoEnhance by selecting Enhance Off.

d Windows/Mac OS X

Change the Scene Correction setting in PhotoEnhance from Auto Correct to any other option. If changing the
setting does not work, use any color correction method other than PhotoEnhance.

Related Information
= “Menu Options for Photo Adjustment and Zoom” on page 52
= “Adjusting the Print Color” on page 72

Banding Appears at Intervals of Approximately 2.5 cm

(d Align the print head.
[ Select the appropriate paper type setting for the type of paper loaded in the printer.

Related Information
= “Aligning the Print Head” on page 109
= “List of Paper Types” on page 23

Copy Quality Is Poor

Check the following if uneven colors, smears, dots, or straight lines appear in the copied image.
(A Clean the paper path.
[d Clean the scanner glass.

(4 Do not press too hard on the original or the document cover when you are placing the originals on the scanner
glass. Uneven colors, smears, or dots may appear when the original or the document cover is pressed too hard.

[ If a moiré (cross-hatch) pattern appears, change the reduce and enlarge setting or place the original at a slightly
different angle.

[ When the paper is smeared, lower the copy density setting.

Related Information

= “Cleaning the Paper Path” on page 110

= “Cleaning the Scanner Glass” on page 110
=» “Menu Options for Copy Mode” on page 80
= “Print Quality is Poor” on page 142
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An Image of the Reverse Side of the Original Appears in the Copied
Image

[ For a thin original, place the original on the scanner glass and then place a piece of black paper over it.

[d Lower the copy density setting on the control panel.

Related Information

= “Menu Options for Copy Mode” on page 80

The Position, Size, or Margins of the Printout Are Incorrect

[d Load paper in the correct direction, and slide the edge guides against the edges of the paper.

[d When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a
symbol on the frame of the scanner glass. If the edges of the copy are cropped off, move the original slightly
away from the corner.

(4 When placing the originals on the scanner glass, clean the scanner glass and the document cover. If there is dust
or stains on the glass, the copy area may extend to include the dust or stains, resulting in the wrong copying
position or small images.

[ Select the appropriate paper size setting.

(d Adjust the margin setting in the application so that it falls within the printable area.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Cleaning the Scanner Glass” on page 110

= “Printable Area” on page 155

Multiple Originals are Copied onto a Single Sheet

When you place multiple originals on the scanner glass to copy them separately, but they are copied onto a single
sheet, place the originals at least 5 mm apart. If the problem continues, place one original at a time.

Cannot Print Without Margins

Make borderless setting in the print settings. If you select a paper type that does not support borderless printing,
you cannot select Borderless. Select a paper type that supports borderless printing.

Related Information

= “Menu Options for Paper and Print Settings” on page 53
= “Menu Options for Copy Mode” on page 80

= “Printing Basics - Windows” on page 55

= “Printing Basics - Mac OS X” on page 56
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Edges of the Image are Cropped During Borderless Printing

During borderless printing, the image is slightly enlarged and the protruding area is cropped. Select a smaller
enlargement setting.

(d Control panel
Change the Expansion setting.

(J Windows
Click Settings next to the Borderless checkbox on the printer driver's Main tab, and then change the settings.

(d Mac OS X

Change the Expansion setting from the print dialog's Print Settings menu.

Related Information
= “Menu Options for Paper and Print Settings” on page 53
= “Menu Options for Copy Mode” on page 80

Printing Position of Photo Stickers is Incorrect

Adjust the printing position in the Printer Setup > Stickers menu on the control panel.

Related Information

= “Menu Options for Printer Setup” on page 113

Printing Position on a CD/DVD is Incorrect

Adjust the printing position in the Printer Setup > CD/DVD menu on the control panel.

Related Information

= “Menu Options for Printer Setup” on page 113

Paper Is Smeared or Scuffed

(4 When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct
direction and slide the edge guides to the edges of the paper.

[ When vertical banding appears or the paper is smeared, clean the paper path.
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[ If thick paper is scuffed, enable the reduce scuffing setting. If you enable this setting, print quality may decline
or printing may slow down.

J Control panel

Select Setup > Printer Setup from the home screen, and then enable Thick Paper.

[d Windows

Click Extended Settings on the printer driver's Maintenance tab, and then select Thick Paper and
Envelopes.

[d Mac OS X

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the Thick paper and
envelopes setting.

[ When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.

Related Information

= “Loading Paper in the Paper Cassette 1” on page 24

= “Loading Paper in the Paper Cassette 2” on page 28

= “Loading Paper in the Rear Paper Feed Slot” on page 31
= “Cleaning the Paper Path” on page 110

= “Print Quality is Poor” on page 142

Paper is Smeared During Automatic 2-Sided Printing

When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set
the print density to lower and the drying time to longer.

Related Information
= “Printing on 2-Sides” on page 59
= “Menu Options for Copy Mode” on page 80

Printed Characters Are Incorrect or Garbled

[d Connect the USB cable securely to the printer and the computer.
[d Cancel any paused print jobs.

(d Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

Related Information

= “Canceling Printing” on page 79

The Printed Image Is Inverted

Clear any mirror image settings in the printer driver or the application.
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J Windows

Clear Mirror Image on the printer driver's More Options tab.

1 Mac OS X

Clear Mirror Image from the print dialog's Print Settings menu.

The Printout Problem Could Not be Cleared

If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information
= “Uninstalling Applications” on page 129
= “Installing Applications” on page 131

Other Printing Problems

Printing Is Too Slow

(d Close any unnecessary applications.
[d Lower the quality setting. High quality printing slows down the printing speed.

[d Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

J Control panel

Enable Bidirectional in the print settings.
J Windows

Select High Speed on the printer driver's More Options tab.
1 Mac OSX

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.

[ Disable Quiet Mode.
J Control panel
From the home screen, select Quiet Mode, and then disable it.
1 Windows
Disable the Quiet Mode setting on the printer driver's Main tab.

[d Mac OS X

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

Related Information

= “Menu Options for Paper and Print Settings” on page 53

148



User's Guide

Solving Problems

Printing Slows Down Dramatically During Continuous Printing

Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8

If you want to stop printing from your computer, make the following settings.

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System

Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and
then add the printer again.

Related Information
=» “Web Config” on page 119

Cannot Start Scanning

(d Connect the USB cable securely to the printer and the computer.

[ If you are using a USB hub, try to connect the printer directly to the computer.

(d If you cannot scan over a network, see the Network Guide.

[ If you scan at a high resolution over a network, a communication error may occur. Lower the resolution.

[d Make sure you select the correct printer (scanner) if a scanner list is displayed when you start EPSON Scan.
[ If you are using any TWAIN-compliant applications, select the printer (scanner) you are using.

(d In Windows, make sure the printer (scanner) is displayed in Scanner and Camera. The printer (scanner) should
be displayed as "EPSON XXXXX (printer name)". If the printer (scanner) is not displayed, uninstall and then
re-install EPSON Scan. See the following to access Scanner and Camera.

[d Windows 8.1/Windows 8

Select Desktop > Settings > Control Panel, enter "Scanner and Camera" in the search charm, click Show
Scanner and Camera, and then check if the printer is displayed.

[d Windows 7

Click the start button and select Control Panel, enter "Scanner and Camera" in the search charm, click View
scanners and cameras, and then check if the printer is displayed.

[d Windows Vista

Click the start button, select Control Panel > Hardware and Sound > Scanners and Cameras, and then
check if the printer is displayed.

[d Windows XP

Click the start button, select Control Panel > Printers and Other Hardware > Scanner and Cameras, and
then check if the printer is displayed.

[ If you cannot scan using any TWAIN-compliant applications, uninstall and then reinstall the TWAIN-
compliant application.

(J For Mac OS X with an Intel processor, if other Epson scanner drivers except for EPSON Scan, such as Rosetta or
PPC are installed, uninstall them and EPSON Scan, and then reinstall EPSON Scan.
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Related Information
= “Uninstalling Applications” on page 129
= “Installing Applications” on page 131

Cannot Start Scanning when Using the Control Panel

[d Make sure EPSON Scan and Epson Event Manager are installed correctly.
[d Check the scanning setting assigned in Epson Event Manager.

Related Information
= “Cannot Start Scanning” on page 149
= “Epson Event Manager” on page 127

Scanned Image Problems

Scan Quality Is Poor

[d Clean the scanner glass.

[d Do not press too hard on the original or the document cover when you are placing the originals on the scanner
glass. Uneven colors, smears, or dots may appear when the original or the document cover is pressed too hard.

[d Remove dust from the original.
(d Make the appropriate document type settings.
[d Scan at a higher resolution.

[d Adjust the image in EPSON Scan, and then scan. See the EPSON Scan help for details.

Related Information
= “Cleaning the Scanner Glass” on page 110
= “Menu Options for Scanning” on page 89

Characters Are Blurred
(d In Home Mode or Office Mode in EPSON Scan, select Image Option as the Image Adjustments setting, and
then select Text Enhancement.
(d In Professional Mode in EPSON Scan, select Document as the Auto Exposure Type in the Original settings.
(d Adjust the threshold settings in EPSON Scan.
(d Home Mode
Select Black & White as the Image Type setting, click Brightness, and then adjust the threshold.
d Office Mode
Select Black & White as the Image Type setting, and then adjust the threshold.

1 Professional Mode
Select Black & White as the Image Type setting, and then adjust the threshold setting.
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[d Scan at a higher resolution.

Related Information

= “Menu Options for Scanning” on page 89

An Image of the Reverse Side of the Original Appears in the
Scanned Image

[ For a thin original, place the original on the scanner glass and then place a piece of black paper over it.
[d Make the appropriate document type settings.

(d In Home Mode or Office Mode in EPSON Scan, select Image Option as the Image Adjustments setting, and
then select Text Enhancement.

Related Information

= “Menu Options for Scanning” on page 89

Moire (Cross-Hatch) Patterns Appear in the Scanned Image

[ Place the original at a slightly different angle.
[ Select Descreening in any mode other than Full Auto Mode in EPSON Scan.

(d Change the resolution setting.

Related Information

= “Menu Options for Scanning” on page 89

Scanning Area or Direction Is Not Correct

(d When placing the originals on the scanner glass, align the corner of the original with the corner indicated by a
symbol on the frame of the scanner glass. If the edges of the scanned image are cropped off, move the original
slightly away from the corner.

[ Clean the scanner glass and the document cover. If there is dust or stains on the glass, the scanning area may
extend to include the dust or stains, resulting in the wrong scanning position or small images.

[ When you place multiple originals on the scanner glass to scan them separately, but they are scanned onto a
single file, place the originals at least 20 mm (0.8 inch) apart. If the problem continues, place one original at a
time.

[ Set the scan area correctly.

[ When scanning using Full Auto Mode or the thumbnail preview in EPSON Scan, move the original 4.5 mm
(0.18 inch) away from the edges of the scanner glass.

[ When using the thumbnail preview for a large original in Home Mode or Professional Mode in EPSON Scan,
the scanning area may not be correct. When previewing in EPSON Scan, create marquees of the area you want
to scan on the Preview tab in the Preview window.

(J If Auto Photo Orientation in EPSON Scan does not work as intended, see the EPSON Scan help.
(d Clear Auto Photo Orientation in EPSON Scan.
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[ When scanning with EPSON Scan the available scanning area may be restricted if the resolution setting is too
high. Lower the resolution or adjust the scanning area in the Preview window.

Related Information

= “Placing Originals on the Scanner Glass” on page 35
= “Cleaning the Scanner Glass” on page 110

= “Menu Options for Scanning” on page 89

The Scanned Image Problem Could Not be Cleared

If you have tried all of the solutions and could not solve the problem, click Configuration in a mode other than
Full Auto Mode in the EPSON Scan window, and then click Reset All on the Other tab to initialize the EPSON
Scan settings. If initialization does not solve the problem uninstall and re-install EPSON Scan.

Related Information
= “Uninstalling Applications” on page 129
= “Installing Applications” on page 131

Other Scanning Problems

Cannot Scan in Full Auto Mode in EPSON Scan

(4 You cannot scan to PDF/Multi-TIFF format continuously in Full Auto Mode. Scan in a mode other than Full
Auto Mode.

(d See the EPSON Scan help for other way of solving problems.

Thumbnail Preview Does Not Work Properly

See the EPSON Scan help.

Scanning Is Too Slow

[ Lower the resolution.
[ Disable Quiet Mode.
[d Control Panel

From the home screen, select Quiet Mode, and then disable it.

[ EPSON Scan

Select a mode other than Full Auto Mode, click Configuration, and then disable Quiet Mode on the Other
tab.

Related Information

= “Menu Options for Scanning” on page 89
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Scanning Stops when Scanning to PDF/Multi-TIFF

[d When scanning large volumes, we recommend scanning in grayscale.
[ Increase the free space on the computer's hard disk. Scanning may stop if there is not enough free space.

[d Try scanning at a lower resolution. Scanning stops if the total data size reaches the limit.

Related Information

= “Menu Options for Scanning” on page 89

Other Problems

Slight Electric Shock when Touching the Printer

If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud

If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

[ Control Panel

From the home screen, select Quiet Mode, and then enable it.

d Windows
Enable Quiet Mode on the Main tab in the printer driver.

(d Mac OS X

Select System Preferences from the " menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

[ EPSON Scan
Click Configuration, and then enable Quiet Mode on the Other tab.

Cannot Save Data to a Memory Device

[d Use a memory device that is supported by the printer.
[d Check that the memory device is not write protected.

[d Check that the memory device has enough available memory. If the available memory is low, data cannot be
saved.

Related Information

= “Supported External Storage Device Specifications” on page 159

Application Is Blocked by a Firewall (for Windows Only)

Add the application to the Windows Firewall allowed program in security settings on the Control Panel.
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"?" Is Displayed on the Photo Selection Screen

"?" is displayed on the LCD screen when the image file is not supported by the product.

Related Information

= “Supported Data Specifications” on page 159
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Technical Specifications
Printer Specifications
Print Head Nozzle Placement Black ink nozzles: 180

Color ink nozzles: 180 for each color

Weight of Paper Plain Paper 64 to 90 g/m*(17 to 24lb)

Envelopes Envelope #10, DL, C6: 75 to 90 g/m? (20 to 24 Ib)

Printable Area

Printable Area for Single Sheets

Print quality may decline in the shaded areas due to the printer's mechanism.

Normal printing

AR ;[C A 3.0mm (0.12iin.)
B 3.0mm (0.12in.)
C 41.0mm (1.61in.)
At j D D 37.0mm (1.46 in.)
! 1
B B

Borderless printing

A A 44,0 mm (1.73in.)

B 40.0 mm (1.57 in.)

Printable Area for Envelopes

Print quality may decline in the shaded areas due to the printer's mechanism.
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AH IC A 3.0mm (0.12in.)
B 5.0 mm (0.20in.)
C 18.0 mm (0.71in.)
A LID D 41.0mm (1.61in.)
B B

Printable Area for CD/DVD

Print quality may decline in the shaded areas due to the printer's mechanism.

A 18 mm (0.71in.)
B 43 mm (1.69in.)
C 116 mm (4.57 in.)
D 120 mm (4.72in.)
Scanner Specifications

Scanner Type Flatbed

Photoelectric Device cis

Maximum Document Size 216 %297 mm (8.5x 11.7in.)

A4, Letter
Resolution 4800 dpi (main scan)

4800 dpi (sub scan)

Color Depth Color

[ 48 bits per pixel internal (16 bits per pixel per color internal)
1 24 bits per pixel external (8 bits per pixel per color external)
Grayscale

4 16 bits per pixel internal

1 8 bits per pixel external

Black and white

1 16 bits per pixel internal

[ 1 bits per pixel external

Light Source LED

Interface Specifications

For Computer Hi-Speed USB
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For External USB Devices and Hi-Speed USB
PictBridge
Wi-Fi Specifications
Standards IEEE802.11b/g/n"!
Frequency Range 24 GHz
Coordination Modes Infrastructure, Ad hoc™2, Wi-Fi Direct™3 "4
Wireless Securities WEP (64/128bit), WPA2-PSK (AES)">

*1  Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.
*2  Not supported for IEEE 802.11n.
*3  Not supported for IEEE 802.11b.

*4  Simple AP mode is compatible with a Wi-Fi connection (infrastructure) or an Ethernet connection. See the Network Guide for
more details.

*5  Complies with WPA2 standards with support for WPA/WPA2 Personal.

Ethernet Specifications

Standards IEEE802.3i (10BASE-T)™
IEEE802.3u (100BASE-TX)

|EEE802.3az (Energy Efficient Ethernet)"?

Communication Mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps
Full duplex, 100Mbps Half duplex

Connector RJ-45

*1  Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

*2  The connected device should comply with IEEE802.3az standards.

Security Protocol

SSL/TLS HTTPS Server/Client, IPPS

Supported Third Party Services

AirPrint Print iOS 5 or later/Mac OS X v10.7.x or later

Scan Mac OS X v10.9.x or later

Google Cloud Print
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External Storage Device Specifications

Supported Memory Card Specifications

Compatible Memory Cards Maximum Capacities
Memory Stick Duo 128MB
Memory Stick PRO Duo 32GB
Memory Stick PRO-HG Duo
MagicGate Memory Stick Duo 128MB
Memory Stick Micro” 32GB
miniSD" 2GB
miniSDHC" 32GB
microSD" 2GB
microSDHC" 32GB
microSDXC" 64GB
SD 2GB
SDHC 32GB
SDXC 64GB
CompactFlash 32GB
MicroDrive 6GB

*  Attach an adapter to fit the memory card slot. Otherwise, the card may get stuck.

Supported memory card voltages

3.3 V type, dual voltage (3.3 V and 5V) type (supply voltage: 3.3 V)

5V memory cards are not supported.
Maximum supply current

4 Memory Stick, Memory Stick PRO: 100 mA
(d SD: 200 mA

4 CompactFlash, MicroDrive: 500 mA
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Supported External Storage Device Specifications

Compatible External Storage Maximum Capacities

Devices

CD-R Drive™! CD-ROM*2/CD-R: 700 MB

DVD-R Drive™! DVD-ROM2/DVD-R: 4.7 GB

Blu-ray Drive™ (CD-RW, DVD+R, DVD+RW, DVD-RAM, and Blu-ray Disc™ are not supported.)
MO Drive™ 1.3GB

HDD*! 2 TB (formatted in FAT, FAT32, or exFAT)

USB Flash Drive

*1  We do not recommend using external USB devices that are powered by USB. Use only external USB devices with

independent AC power sources.

*2  Readonly.

You cannot use the following devices:

[d A device that requires a dedicated driver

[d A device with security settings (password, encryption, and so on)
(d A device with a built-in USB hub

Epson cannot guarantee operations for all externally connected devices.

Supported Data Specifications

or 2.0"2 compliant

File Format JPEG with the Exif Version 2.3 standard taken by digital cameras DCF*! version 1.0

Image Size Horizontal: 80 to 10200 pixels
Vertical: 80 to 10200 pixels

File Size Less than 2 GB

Maximum Number of Files 9990

*1  Design rule for Camera File system.
*2  Photo data stored in the built-in memory of a digital camera is not supported.

Note:

"¢"is displayed on the LCD screen when the printer cannot recognize the image file. In this situation, if you select a multiple

image layout, blank sections will be printed.
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Dimensions

Storage

0 Width: 479 mm (18.9in.)
d Depth:356 mm (14.0in.)
[ Height: 148 mm (5.8 in.)
Printing

1 Width: 479 mm (18.9in.)
(1 Depth: 668 mm (26.3 in.)
d Height:295mm (11.6in.)

Weight”

Approx. 8.7 kg (19.2 Ib)

* : Without the ink cartridges, power cord, and the CD/DVD tray.

Electrical Specifications

Model 100 to 120 V Model 220 to 240V Model
Rated Frequency Range 50 to 60 Hz 50 to 60 Hz
Rated Current 0.7A 0.35A

Power Consumption (with USB Con-
nection)

Standalone copying: Approx. 17 W
(ISO/IEC24712)

Ready mode: Approx. 8.2 W
Sleep mode: Approx. 1.2 W
Power off: Approx. 0.2 W

Standalone copying: Approx. 17 W
(ISO/IEC24712)

Ready mode: Approx. 8.2 W
Sleep mode: Approx. 1.2 W
Power off: Approx. 0.4 W

Note:

[ Check the label on the printer for its voltage.

Environmental Specifications

Operation Use the printer within the range shown in the following graph.
%
80
55
20
10 27 35 ©
Temperature: 10 to 35°C (50 to 95°F)
Humidity: 20 to 80% RH (without condensation)
Storage Temperature: -20 to 40°C (-4 to 104°F)"

Humidity: 5 to 85% RH (without condensation)
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* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Cartridges

Storage Temperature -30to0 40 °C (-22 to 104 °F)"

Freezing Temperature -16°C(3.2°F)

Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

System Requirements

[ Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-bit)/Windows Vista (32-bit, 64-
bit)/Windows XP Professional x64 Edition/Windows XP (32-bit)

[ Mac OS X v10.10.x/Mac OS X v10.9.x/Mac OS X v10.8.x/Mac OS X v10.7.x/Mac OS X v10.6.8

Note:
[ Mac OS X may not support some applications and features.

(A The UNIX File System (UFS) for Mac OS X is not supported.

Regulatory Information

Standards and Approvals

Standards and Approvals for U.S. Model

Safety UL60950-1
CAN/CSA-C22.2 No.60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module.
Manufacturer: Askey Computer Corporation
Type: WLU6320-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject
to licensing.
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Standards and Approvals for European Model

Low voltage directive 2006/95/EC EN60950-1

EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024

R&TTE directive 1999/5/EC EN300 328
EN301 489-1
EN301 489-17
EN60950-1

For European users

We, Seiko Epson Corporation, hereby declare that the following equipment Model is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC:

C493C

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-

recommended modification of the products.

Standards and Approvals for Australian Model

EMC AS/NZS CISPR22 Class B

Epson hereby declares that the following equipment Models are in compliance with the essential requirements and
other relevant provisions of AS/NZS4268:

C493C

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

Restrictions on Copying

Observe the following restrictions to ensure the responsible and legal use of the printer.
Copying of the following items is prohibited by law:

(d Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

[d Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

[d Government-issued revenue stamps, and securities issued according to legal procedure
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Exercise caution when copying the following items:

[ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.
Note:

Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting the Printer

When you need to transport the printer to move or for repairs, follow the steps below to pack the printer.

A Caution:

Be careful not to trap your hand or fingers when opening or closing the scanner unit. Otherwise you may be injured.

g Important:

1 When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

1 Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the
printer from printing.

1. Turn off the printer by pressing the O button.

2. Make sure the power light turns off, and then unplug the power cord.

g Important:

Unplug the power cord when the power light is off. Otherwise, the print head may not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.
4. Make sure there is no memory card inserted.
5. Remove all of the paper from the printer.

6. Make sure there are no originals on the printer.
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7. Open the scanner unit with the document cover closed. Secure the ink cartridge holder to the case with tape.

8. Close the scanner unit.

9. Prepare to pack the printer as shown below.

10. Pack the printer in its box, using the protective materials.

When you use the printer again, make sure you remove the tape securing the ink cartridge holder. If print quality
has declined the next time you print, clean and align the print head.

Related Information

= “Part Names and Functions” on page 14

= “Checking and Cleaning the Print Head” on page 107
= “Aligning the Print Head” on page 109

Accessing a Memory Card From a Computer

You can write or read data on an external storage device such as a memory card that has been inserted in the
printer from a computer.
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n Important:
N

Insert a memory card after removing write protection.

A If an image is saved to the memory card from a computer, the image and the number of photos are not refreshed
on the LCD screen. Remove and insert the memory card again.

[ When sharing an external device inserted in the printer between computers connected over USB and over a
network, write access is only allowed to the computers that are connected by the method you selected on the
printer. To write to the external storage device, enter Setup on the control panel and select File Sharing Setup
and a connection method. Data can be read by computers connected over USB and over a network.

1 To write to the external storage device connected to the computer over a network, enter Setup on the control
panel and select File Sharing Setup, and then give a priority to a network connection.

Note:
It takes a while to recognize data from a computer if a large external storage device, such as 2TB HDD, is connected.

Windows

Select an external storage device in Computer or My Computer. The data on the external storage device is
displayed.

Note:

If you connected the printer to the network without the software disc or Web Installer, map a memory card slot or USB port
as a network drive. Open Run and enter a printer name \\XXXXX or a printer's IP address \\XXX. XXX XXX.XXX to
Open:. Right-click a device icon displayed to assign the network. The network drive appears in Computer or My Computer.

Mac OS X
Select a corresponding device icon. The data on the external storage device is displayed.

Note:
(A To remove an external storage device, drag and drop the device icon to the trash icon. Otherwise, data in the shared drive
may not be displayed correctly when another external storage device is inserted.

(A To access an external storage device through the network, select Go > Connect to Server from the menu on the desktop.
Enter a printer name cifs://XXXXX or smb://XXXXX (Where "XXXXX" is the printer name) in the Server Address, and
then click Connect.

Related Information
= “Inserting a Memory Card” on page 37
= “External Storage Device Specifications” on page 158

Where to Get Help

Technical Support Web Site

If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/
http://www.epson.eu/Support (Europe)
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If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number

(The serial number label is usually on the back of the product.)
1 Product model

[d Product software version

(Click About, Version Info, or a similar button in the product software.)
(4 Brand and model of your computer
[d Your computer operating system name and version
[d Names and versions of the software applications you normally use with your product

Note:

Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product manuals,
we provide the following sources for obtaining information:

Internet URL
http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The
site provides a download area for drivers, Epson contact points, new product information and technical support (e-
mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the
Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staft
can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many
types of queries are answered here.

The Helpdesk numbers are:
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Phone: 1300 361 054

We encourage you to have all the relevant information on hand when you ring. The more information you prepare,
the faster we can help solve the problem. This information includes your Epson product manuals, type of
computer, operating system, application programs, and any information you feel is required.
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